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AnywhereUSB® Plus User Guide
AnywhereUSB® Plus is a Remote USB 3.1 Hub that implements USB over IP® technology over Gigabit
Ethernet networks. The Hub enables communication with USB-enabled devices from virtualized
systems and from remote host computers. You can securely deploy AnywhereUSB® Plus Remote USB
3.1 Hubs in non-secure environments, making it ideal for point-of-sale, kiosks, surveillance, industrial
automation, or any mission-critical enterprise application. This Gigabit Ethernet-attached solution
provides 2, 8, or 24 USB 3.1 ports to connect a wide range of peripheral devices such as USB license
dongles, scanners, printers, cameras, storage media, or other USB devices. The 8- and 24-port models
provide support for 10 Gigabit Ethernet and include SFP+ interfaces.

User roles
The different user roles that work with the AnywhereUSB Plus Hub are described in the table below.
Role

Description

Windows administrator

The Windows administrators have the Windows permissions to
install the AnyhwhereUSB Manager software on the computer.

Hub administrator

The Hub administrators have access to the Hub password. This
enables the administrators to access and perform all activities
to configure and maintain the Hub using the Configuration
and Management web UI and the CLI commands.

User

A user can log into their computer and access the
AnywhereUSB Manager that has been installed on the
computer by the Windows administrator. Within the
AnywhereUSB Manager, the user can connect to the groups on
the remote Hubs to which they have been given access by a
Hub administrator.
A user cannot access the the Configuration and Management
web UI or use the CLI commands.
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Terminology

Terminology
Role

Description

Computer

The physical or virtual equipment (such as a PC, laptop, or virtual
machine), which is used to remotely access the AnywhereUSB Plus
Hub.

Client ID

The client ID is a unique identifier assigned to a user account the first
time a user logs in to a computer and opens the
AnywhereUSB Manager.
During this process, the AnywhereUSB Manager creates a secure
identity certificate that is associated with the client ID. This certificate
is used to validate your user account with the Hub. For more
information, see Client ID.

Group

A group is a set of USB ports on an AnywhereUSB Plus Hub with
exclusive access to a single user account. Each USB port can be
assigned to only one group by the Hub administrator.
When you log into the computer and connect to a Hub, you are allowed
to connect to any groups assigned to your client ID.
See Create groups and assign to client IDs for more information.
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Get started
This section explains what comes with each AnywhereUSB® Plus model, how to install the necessary
software, and how to connect the hardware. After you have verified the AnywhereUSB® Plus Hub
components, the software installation, hardware connection, and initial connection process must be
done individually for each computer.
Note The steps in this process can only be done by an administrator. Once the setup is complete, any
user can connect to a group, as described in step 6 below, Connect to groups.
1. Verify product components.
2. Install the AnywhereUSB Manager.
3. Connect the hardware.
4. Verify initial connection.
5. After you have completed your initial connection, you can create groups and assign ports to
each group. Once this step is complete, you can specify the groups that a client ID is allowed to
access. See Create groups and assign to client IDs.
6. Connect to groups. Any user (administrator or non-administrator) can open the AnywhereUSB
Manager and connect to the Hubs and groups to which access is allowed.
7. The Hub administrator can use the Configuration and Management web user interface
(web UI) to configure networks parameters, services, and other Hub features. You can update
the firmware, back up the configuration, view system information and logs, and reboot the
Hub. See Administrators: Configure the AnywhereUSB® Plus in the web user interface.

Verify product components
All AnywhereUSB® Plus models include the AnywhereUSB® Plus device in the box. Additional
equipment may be required or may be optional.
n AnywhereUSB 2 Plus components
n

AnywhereUSB 8 Plus components

n

AnywhereUSB 24 Plus components

AnywhereUSB® Plus User Guide
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Verify product components

AnywhereUSB 2 Plus components
Verify that you have the following included and required additional equipment.
Equipment

Description

Included equipment

AnywhereUSB 2-port device.

Required additional equipment

n

STP Cat 7 Ethernet cable

n

Power supply kit: Digi part number 76000965

Item

Name

Description

1

Ethernet connector

Connect the STP Cat 7 Ethernet cable.

2

USB LEDs and ports

The USB port supports 1.1, 2.0, and 3.1 USB devices.
The LED illuminates as follows, based on the speed of the USB
device:
n 1.1 (Full speed): Yellow
n

2.0 (High speed): Green

n

3.1 (Super speed): Blue

3

Reset button

Use this button to reset the AnywhereUSB® Plus Hub
configuration to factory defaults. See Use the Reset button to
restore factory defaults.

4

Power LED

The LED is solid blue when the device is powered on.

5

Power connector

Connect the power supply.
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Verify product components

AnywhereUSB 8 Plus components
Verify that you have the following included, required, and optional equipment.
Equipment
Included equipment

Required additional equipment

Optional equipment

AnywhereUSB® Plus User Guide

Description
n

AnywhereUSB 8-port device

n

Power supply

n

Rack mounting brackets and screws

n

STP Cat 7 Ethernet cable

n

IEC 60320 power cord

n

SFP+ module

n

RS232 DB9 Console cable

11
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Verify product components

Item

Name

Description

1

USB port
LEDs

The USB ports support 1.1, 2.0, and 3.1 USB devices.
The LED illuminates as follows, based on the speed of the USB device:
n 1.1 (Full speed): Yellow

2

ETH1

n

2.0 (High speed): Green

n

3.1 (Super speed): Blue

Connect a Cat 7 STP Ethernet cable.
Note Digi recommends that you use either the Ethernet cable or the
SFP+ module. If both the Ethernet cable and the SFP+ module are
connected, the SFP+ module will have priority.

AnywhereUSB® Plus User Guide

12

Get started

Verify product components

Item

Name

Description

3

SFP+

Connect an SFP transceiver module for fiber connection, such as Finisar
Network FTLX8574D3BCL SFP+.

4

DB9
console

Used to access a console using the RS232 DTE interface.

5

Fan

The LED shows the status of the fan:
n Solid green when the fan is running within normal range of use.
n

Solid red if the fan slows down or the Hub is overheating.

5

Wi-Fi
Service

Reserved for future use.

5

User

LED used for the Find Me feature. When this feature is activated, the
LED blinks orange and then green. You can configure the Find Me
feature in the web UI or by using the findme CLI command.

5

Power

The LED is solid blue when the Hub is powered.

5

WWAN1
Signal

Reserved for future use.

5

WWAN1
Service

Reserved for future use.

6

BT

Reserved for future use.

7

Wi-Fi1

Reserved for future use.

8

Wi-Fi2

Reserved for future use.

9

Wi-Fi3

Reserved for future use.

10

Wi-Fi4

Reserved for future use.

11

WWAN2

Reserved for future use.

12

WWAN1

Reserved for future use.

13

Reset
button

Use this button to reset the AnywhereUSB® Plus Hub configuration to
factory defaults. See Use the Reset button to restore factory defaults.

14

Power
connector

Connect the power supply.
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Verify product components

AnywhereUSB 24 Plus components
Verify that you have the following included, required, and optional equipment.
Equipment

Description

Included equipment

AnywhereUSB 24-port device

Required additional equipment

Optional equipment

AnywhereUSB® Plus User Guide

n

STP Cat 7 Ethernet cable

n

IEC 60320 power cord

n

An additional STP Cat 7 Ethernet cable

n

An additional IEC 60320 power cord

n

SFP+ modules

n

RS232 DB9 Console cable
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Verify product components

Item

Name

Description

1

DB9 Console

Used to access a console using the RS232 DTE interface.

2

USB port LEDs

The USB ports support 1.1, 2.0, and 3.1 USB devices.
The LED illuminates as follows, based on the speed of the USB
device:
n 1.1 (Full speed): Yellow

3

ETH 1/2

n

2.0 (High speed): Green

n

3.1 (Super speed): Blue

Connect a Cat 7 STP Ethernet cable. The second Ethernet cable is
optional and used for redundancy.
Note Digi recommends that you use either the Ethernet cable or
the SFP+ module. If both the Ethernet cable and the SFP+ module
are connected, the SFP+ module will have priority.

4

SFP+ 1/2

Connect an SFP transceiver module for fiber connection, such as
Finisar Network FTLX8574D3BCL SFP+. The second SFP+ module is
optional and used for redundancy.

5

Fan1

The LED shows the status of Fan 1:
n Solid green when the fan is running within normal range of
use.
n

5

Fan2

Solid red if the fan slows down or the Hub is overheating.

The LED shows the status of Fan 2:
n Solid green when the fan is running within normal range of
use.
n

Solid red if the fan slows down or the Hub is overheating.

5

User

LED used for the Find Me feature. When this feature is activated,
the LED blinks orange and then green. You can configure the Find
Me feature in the web UI or by using the findme CL command.

5

PSU1

The LED is blue when the Hub is powered, and solid red if the Hub
is not powered or the supply has failed.

5

PSU2

The LED is blue when the Hub is powered, and solid red if the Hub
is not powered or the supply has failed.

5

Wi-Fi Service

Reserved for future use.

5

WWAN1 Service

Reserved for future use.

5

WWAN1 Signal

Reserved for future use.

6

BT

Reserved for future use.
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Install the AnywhereUSB Manager

Item

Name

Description

7

Wi-Fi1

Reserved for future use.

8

Wi-Fi2

Reserved for future use.

9

Wi-Fi3

Reserved for future use.

10

Wi-Fi4

Reserved for future use.

11

WWAN2

Reserved for future use.

12

Core module

Reserved for future use.

13

WWAN1

Reserved for future use.

14

Fan 1

Primary fan.

15

Fan 2

Secondary fan.

16

Power connector

Connect the power supply.

17

Power connector

Connect the second (optional) power supply. This is used for
redundancy.

Reset button

The reset button is on the side of the Hub.
Press this button to reset the AnywhereUSB® Plus Hub
configuration to factory defaults. See Use the Reset button to
restore factory defaults.

Install the AnywhereUSB Manager
The Anywhere USB Manager software must be downloaded from the Digi support site and installed
on your computer. After the manager software installs, the AnywhereUSB Manager launches. The
AnywhereUSB Manager automatically discovers AnywhereUSB® Plus Hubs on the local subnet.
The Windows administrator must perform the software install.
Note Once AnywhereUSB Manager has been installed, you do not have to be an administrator to
launch and use the AnywhereUSB Manager.
1. Navigate to https://www.digi.com/support#support-tools.
2. From the Support Downloads section, click Drivers.
3. Find and select AnywhereUSB Plus from the product list.
4. Select your AnywhereUSB Plus model.
5. Select and download the appropriate software for your operating system.
6. Click on the downloaded software to launch the AnywhereUSB Manager installation wizard.
The Welcome screen appears.

AnywhereUSB® Plus User Guide
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Install the AnywhereUSB Manager

7. Click Next. The Ready to Install screen appears.
8. Click Install. A status bar shows the progress of the installation process. When complete, the
Completed screen appears.
9. Select from the options on the screen:
n

Launch AnywhereUSB Manager: Select this option to open the AnywhereUSB
Manager when the installation completes.

n

Run AnywhereUSB Manager at Startup: Select this option to automatically launch
AnywhereUSB Manager each time you log in to your Windows user account.

AnywhereUSB® Plus User Guide
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Connect the hardware

10. Click Finish. The client ID confirmation dialog appears.
11. Enter a unique client ID. See Client ID for more information about how the client ID is used by
your computer and the Hub to create a connection.

12. Click OK. The AnywhereUSB Manager launches.

Connect the hardware
Before you begin, verify that you have your AnywhereUSB® Plus Hub, the required additional
equipment for your Hub, and any additional optional equipment. See Verify product components.
WARNING! Digi recommends that you use a private network to connect the computer to
the Hub, as described in this section. If you do not use a private network, and the same
client ID is assigned to both a known and an unknown computer, there is a risk of
misidentification. In this situation, an unknown computer may connect to the Hub before
the known computer does, resulting in the wrong computer being allowed to connect to
your Hub.

AnywhereUSB® Plus User Guide
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It is recommended that you download a PDF copy of this manual to your computer.
1. Connect one end of a Shielded CAT 7 (STP) Ethernet cable to the Hub.
2. Connect the other end of the Ethernet cable to your computer.
3. Connect the appropriate power supply for your model:
n

AnywhereUSB 2 Plus Hub: Connect the power supply to the Hub, and use the twistlock feature to secure the power supply.

n

AnywhereUSB 8 Plus Hub: Connect the power supply to the Hub and tighten the
screws to secure.

n

AnywhereUSB 24 Plus Hub: Connect one IEC 60320 power cord into the Hub. The
second power cord is used for redundancy.

4. Plug the power supply to an outlet. You may have two power supplies for an AnywhereUSB 24
Plus Hub.
5. Verify that the blue power LED is illuminated.

Verify initial connection
After the hardware has been connected and powered on, and you have installed the AnywhereUSB
Manager, verify that the Hub connection is working as expected. You will need a USB flash drive to
follow the verification process below.
1. Verify that your Hub powered on. The power LED is solid blue.
2. Plug your USB flash drive into port 1 on the Hub.
3. Verify that the USB port 1 LED is solid yellow, green, or blue, depending on whether the USB
flash drive is 1.1, 2.0, or 3.1.
4. If not already open, launch the AnywhereUSB Manager.
5. Expand AnywhereUSB® Plus Hubs to display a list of AnywhereUSB® Plus Hubs.

6. Verify that the serial number of the Hub is in the list. You can find the serial number on the
Hub's label.

AnywhereUSB® Plus User Guide
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Verify initial connection

7. You will notice that the Manager is showing the Hub in an error state, with a red X appearing
next to the Hub name. Click on the Hub to update information in the Hub Status pane. The
Hub State appears as "Unregistered Client ID."
This is a security feature. The Hub administrator needs to allow each new client ID by adding
the client ID to the client list.

8. Before you can register the client ID with the Hub, you must add the client ID to the Hub from
the web UI.
a. Right-click on the Hub and select Open Web UI.
b. A login dialog displays. Enter the following:
n

User name: admin

n

Password: Located on the label on the bottom of the Hub. Note that the
password is case-sensitive and must be typed in exactly as it appears on the
label.

Note The first time you launch the web UI, a warning dialog may appear if your
internet connection is not private. In this situation, continue to access the device.
The log in dialog appears.
c. Click Login. The web UI appears.
d. Click AnywhereUSB from the Configuration section. The AnywhereUSB
Configuration page appears.
e. In the Client Settings section, click Add Client. A new row labeled "New Client" is
added to the client list and the Settings for Client section is populated for the new
client.
f. In the Client ID field, enter the client ID you assigned to your computer when you
installed the AnywhereUSB Manager.
g. In the Description field, enter a descriptive name for the computer. This step is
optional.
h. Click the check box next to group 1.
i. Click Apply to save the Hub settings.
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Verify initial connection

9. Open the AnywhereUSB Manager. The Manager connects to the Hub.
10. Expand the Hub to display the groups.

11. Expand Group 1 to display the USB flash drive connected to Group 1.

12. Right-click on Group 1 and select Connect to Group. The USB flash drive is available in
Windows.
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Create groups and assign to client IDs
For each Hub, the Hub administrator can assign a number of USB ports to a group. The Hub
administrator can also assign groups to client IDs. Groups are created and assigned to client IDs in the
AnywhereUSB page in the web UI.
When the client ID connects to a Hub, the computer is allowed to access the ports in the groups
assigned to the client ID. The same groups can be assigned to more than one client ID on a Hub. Note
that connecting to a group is exclusive and only one client can connect to a group at a time.
1. Add client IDs to the client list.
2. Create groups and assign ports to the group.
3. Assign a group to a client ID.

Create groups and assign ports to the group
In the AnywhereUSB page in the web UI, you can assign a name to each group, and specify the ports
in each group. Each port can only be assigned to one group. Any unassigned ports are included in the
Unassigned row that displays beneath the list of groups.
If a group has ports assigned to it, the group will display in the AnywhereUSB Manager, even if a USB
device is not connected to a port. You can reassign the unused ports in a group so the group does not
appear in the AnywhereUSB Manager. See Hide a group in the AnywhereUSB Manager.
1. Open the web UI for your selected Hub.
2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.
3. In the Group Description field, enter a name for a group. This name displays in the Group
Name field in the Group Status pane in the Anywhere USB Manager.
4. In the row for the group, select the ports for that group. Each port on a Hub can be assigned to
only one group. Ports that are not assigned to a group can be put in the default Unassigned
group.
5. Repeat the steps 3 and 4 for each group you want to create.
6. When done, click Apply to save the changes.
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Assign a group to a client ID

Assign a group to a client ID
You can assign the groups to a client ID. When the client ID connects to the Hub, the computer can
access all of the ports in the specified groups.
1. Open the web UI.
2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.
3. In the client list in the Client Settings section, select the client ID to which you want to assign
groups. Information about the selected client ID displays in the Settings for Client section.
4. Click the check box next to a group to which the computer is allowed access. As you select
groups, the selected group numbers appear in the Group Access field in the Settings for
Client section.
You can also manually enter group numbers in the Group Access field.
5. Click Apply to save the changes.
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Connect to a group or USB device in the
AnywhereUSB Manager
When you connect to a group, you are given exclusive access to all of the ports in the group to which
you are allowed access. All other users are blocked from access to the ports in that group until you
disconnect from the group. A user can connect to more than one group at a time.
Note If you have enabled auto connect for a group, you are automatically connected to those groups
when you log in to your computer and AnywhereUSB Manager opens automatically, or when you
manually open and log into AnyhwereUSB Manager. See Configure auto connect.
When a USB device is plugged in to a port on a Hub, the device displays in the list of devices in the
group. Note that a group may have ports that do not have a connected device. Only ports with a
connected USB device display in the AnywhereUSB Manager.

Connect to a group or a USB device in the AnywhereUSB Manager
You can connect to all of the USB devices and ports in a group, or to one device in a group.
n Connect to a group: To connect to a group, right-click on the group name and click Connect to
Group.
n

Connect to a USB ports in a group: You can connect to the USB ports in a group depending
on whether you are allowed access to the port and if you are connected to the group:
l

If you are connected to the group, right-click on a USB device name and click Connect to
Device. You are connected to that USB device and to all of the USB ports in the group.

l

If you are not connected to the group, right-click on the USB device name and click Connect
to Group to connect to the group and the USB device.

l

If the group is owned by another user, you are not allowed to connect to the device.

Connect to a group
You can connect to a group so that you have access to the ports in the group. Once you have
connected to a group, no one else can connect to that group. You cannot connect to a group that is
already is use.
When you have connected to a group, a note appears next to the group name, next to the devices in
the group, and in the Group Status pane to show that the device is being used by you.
1. Open the Anywhere USB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
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Connect to a group or USB device in the AnywhereUSB Manager

Connect to a USB device

3. Expand a Hub to display the groups in the Hub.
4. Right-click on the group to which you want to connect.
5. Select Connect to Group. A note appears next to the group name, next to the devices in the
group, and in the Group Status pane to show that the device is being used by you.

Connect to a USB device
You can connect to a USB device in a group to which you have access. You cannot connect to a device
in a group that is already is use by another user.
When you have connected to a device, a note appears next to the device name and in the Device
Status pane to show that the device is being used by you.
1. Open the Anywhere USB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
3. Expand a Hub to display the groups in the Hub.
4. Expand a group to display the USB devices in the group.
5. Right-click on the device to which you want to connect.
6. The connect menu option available depends on whether you are already connected to the
group.
n

Connected to the group: Right-click on the USB device name and click Connect to
Device to connect to the USB device.

n

Not connected to the group: Right-click on the USB device name and click Connect to
Group to connect to the group and the USB device.

A note appears next to the device name and in the Device Status pane to show that the device
is being used by you.
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Connect to a group or USB device in the AnywhereUSB Manager
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Manage the Hubs using the AnywhereUSB Manager
You can use the AnywhereUSB Manager to view the AnywhereUSB Plus Hubs that are allowed to
connect to your computer. You can also connect to groups of USB ports on the Hubs.
By default, the AnywhereUSB Manager is configured to automatically discover Hubs that are
connected to the same network as your computer. You can allow a connection to additional Hubs that
are not on the same network.
Note Before you begin, make sure you have installed the AnywhereUSB Manager.
Start the AnywhereUSB Manager
Rename AnywhereUSB® Plus Hubs, groups, and USB devices
Disconnect from a group or USB device
Configure auto connect
Manage the list of known Hubs
Minimize the AnywhereUSB Manager when launched
Autofind Hubs when the AnywhereUSB Manager launches
Specify search, response, and keepalive intervals for a Hub
View latency graph
View the AnywhereUSB Manager system messages
View AnywhereUSB® Plus license information
Restore AnywhereUSB Manager default configuration
Access the online help from the AnywhereUSB Manager
AnywhereUSB Manager window
Exit the AnywhereUSB Manager
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Start the AnywhereUSB Manager

Note The AnywhereUSB Manager supports the AnywhereUSB Plus family of products: AnywhereUSB
2 Plus, AnywhereUSB 8 Plus, AnywhereUSB 24 Plus. The earlier AnywhereUSB products
(AnywhereUSB 2, AnywhereUSB 5, and AnywhereUSB 14) use a different driver package. For more
information, please refer to the AnywhereUSB product page.

Start the AnywhereUSB Manager
You can search for and launch the Anywhere USB Manager using the Windows application search
feature or from the Digi International Start menu.
If you selected the Run AnywhereUSB Manager at Startup option during the installation process,
the tool launches automatically each time you log into your computer. See Install the AnywhereUSB
Manager.
To manually start the Anywhere USB Manager:
1. Log in to your computer.
2. Double-click the Anywhere USB Manager shortcut on your desktop.

Rename AnywhereUSB® Plus Hubs, groups, and USB devices
Each AnywhereUSB® Plus Hub and group has a default name that displays in the AnywhereUSB
Manager. You can also assign a local name to each Hub, group, or USB device that displays in the
AnywhereUSB Manager, which can help you to uniquely identify your local Hubs, groups, and USB
devices.
The local name is local to the computer on which the AnywhereUSB Manager is running. No other
user can see the local name.
n Assign a local name to a Hub
n

Assign a local name to a group

n

Assign a local name to a USB device

Assign a local name to a Hub
You can give a AnywhereUSB® Plus Hub a local name. The name displays in the Hub Status pane in the
AnywhereUSB Manager and also in the tree view. The local name is local to the computer on which
the AnywhereUSB Manager is running.
Note The Hub local name is different from the default Hub name. For detailed information about the
default name, see Rename a Hub and the groups in a Hub.
1. Open the AnywhereUSB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
3. Right-click on the Hub that you want to give a local name.
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Disconnect from a group or USB device

4. Select the Assign Local Name menu option. A dialog appears.
5. In the field, enter a local name for the Hub.
6. Click OK.

Assign a local name to a group
You can give a group a descriptive local name. The local name displays in the Group Status pane in the
AnywhereUSB Manager and also in the tree view. The local name can be seen only on the computer
on which the AnywhereUSB Manager is running.
Note The group local name is different from the default group name. For detailed information about
the default name, see Rename a Hub and the groups in a Hub.
1. Open the AnywhereUSB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
3. Expand the Hub that has the group you want to give a local name.
4. Right-click on the group that you want to rename.
5. Select the Assign Local Name menu option. A dialog appears.
6. Enter a local name for the group.
7. Click OK.

Assign a local name to a USB device
You can assign a local name to a USB device that displays in the in the Device Status pane and also in
the tree view. The local name is local to the computer on which the AnywhereUSB Manager is
running.
1. Open the AnywhereUSB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
3. Expand the Hub that has the group to which the to USB device is attached.
4. Expand the appropriate group to display the USB devices in the group.
5. Right-click on the USB device that you want to give a local name.
6. Select the Assign Local Name menu option. A dialog appears.
7. In the field, enter a local name for the USB device.
8. Click OK.

Disconnect from a group or USB device
You can disconnect from any group or USB device in the group to which you no longer need access.
n Disconnect from a group
n

Disconnect from a USB device
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Configure auto connect

Disconnect from a group
You can disconnect from a group that has ports you no longer need access to. You are disconnected
from all USB devices and ports in that group. Any other user can then connect to that group.
Note If you have auto connect enabled for the group, you are not allowed to disconnect from the
group. You have to first disable auto connect, and then disconnect from the group. The next time you
log in to your computer, you will not be automatically connected to this group.
1. Open AnywhereUSB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
3. Expand a Hub to display the groups in the Hub.
4. Right-click on the AnywhereUSB® Plus group from which you want to disconnect.
5. Select Disconnect from Group. A note appears in the Group Status pane to show that the
group is not being used.

Disconnect from a USB device
You can disconnect from a USB device to which you no longer need access. You can disconnect from a
USB device that is in a group to which you are connected. Other users cannot connect the USB device,
since you still own the group that the USB device is in.
Note If you have auto connect enabled for the group, you can disconnect from a USB device in the
group, but note that the device will be connected again the next time you log in to your account.
1. Open AnywhereUSB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
3. Expand a Hub to display the groups in the Hub.
4. Expand a group to display the USB devices in the group.
5. Right-click on the USB device from which you want to disconnect.
6. Select Disconnect from Device. A note appears in the Device Status pane to show that the
device is not being used.

Configure auto connect
You can enable the auto connect feature for a group (or multiple groups). This feature ensures that
whenever you open the AnywhereUSB Manager, you are automatically connected to all of the groups
to which you are allowed access that have auto connect enabled.
If you have auto connect enabled for the group, auto connect controls how you can disconnect from a
group:
n You are not allowed to disconnect from the group. You have to first disable auto connect, and
then disconnect from the group. The next time you start your computer, you will not be
automatically connected to this group.
n

You can disconnect from a USB device in the group, but note that the device will be connected
again the next time you start your computer.
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Manage the list of known Hubs

For this to work as expected, you should also choose to automatically start the AnywhereUSB
Manager each time you start your computer.
For example, you can enable auto connect for a group that has a camera connected to a port in the
group. Every time the computer starts, the AnywhereUSB Manager starts and automatically
connects the camera to your computer.

Enable auto connect for a group
You can choose to automatically connect to a selected group each time you open the AnywhereUSB
Manager.
Note You can disable auto connect at any time.
1. Open AnywhereUSB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
3. Expand a Hub to display the groups in the Hub.
4. Right-click on the AnywhereUSB® Plus group to which you want to automatically connect.
5. Select Enable Auto Connect. If you were not already connected to the group, you are
immediately connected to the group. A note appears next to the group name and in the Group
Status pane to show that you are connected to the group.

Disable auto connect for a group
After you have enabled auto connect for a group, you can disable this option. You will no longer
automatically connect to this group when you open the AnywhereUSB Manager.
1. Open the AnywhereUSB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
3. Expand a Hub to display the groups in the Hub.
4. Right-click on the AnywhereUSB® Plus group to which you no longer want to automatically
connect at start up.
5. Select Disable Auto Connect to turn off the auto connect feature for the group.

Manage the list of known Hubs
You can create a list of Hubs to which your client ID is allowed to connect when you open the
AnywhereUSB Manager. The Hubs you add to the list can be on the same network as your computer,
or on a different network.
Note If the Autofind Hubs option is selected for the Hub in the Preferences dialog, then any Hubs
connected to the same network as your computer are automatically discovered when you open the
AnywhereUSB Manager. The Hubs that have been automatically discovered are not displayed in the
list of known Hubs.
Hubs that you add to the known Hubs list as well as the Hubs that are automatically discovered
display when you open the AnywhereUSB Manager.
Hubs that you have added to the list of Hubs can also be removed from the list if needed.
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Minimize the AnywhereUSB Manager when launched

Add a Hub to the known Hub list
The Hubs you add to the known Hub list can be on the same network as your computer, or on a
different network.
1. Open the AnywhereUSB Manager.
2. Select Configure > Known Hubs. The Known Hubs dialog appears.
3. Click Add. The Add Known Hub dialog appears.
a. In the Hub Address field, enter the Hub IP address.
b. In the Hub port (optional) field, enter the TCP port number. An entry is required if
you have changed the Hub port address. Otherwise, leave the field blank.
4. Click OK. The Hub appears in the Hub list in the Known Hubs dialog.
5. Click Close to close the Known Hubs dialog. The AnywhereUSB Manager attempts to connect
to the new Hub.

Remove a Hub from the known Hub list
You can remove a known Hub that was added to the list.
Working with the known Hubs list and the Autofind Hubs option
You may have a situation where you have added a Hub to the known Hubs list that is also on the same
network as your computer, and you also have the Autofind Hubs option selected for the Hub.
If you remove the Hub from known Hubs list, the Hub will still be automatically found and connected
to your computer when you open the AnywhereUSB Manager.
If you do not want the computer to be able to connect this Hub, you must de-select the Autofind
Hubs option. Note, however, that if this option is de-selected, Hubs on the same network as your
computer will not be automatically found. Only the Hubs in the list of known Hubs will be available
when you open the AnywhereUSB Manager.
1. Open the AnywhereUSB Manager.
2. Select Configure > Known Hubs. The Known Hubs dialog appears.
3. From the list of known Hubs, select the Hub you want to remove.
4. Click Remove.
5. Click Close to close the Known Hubs dialog.

Minimize the AnywhereUSB Manager when launched
You can choose to automatically minimize the AnywhereUSB Manager when it launches.
1. Open AnywhereUSB Manager.
2. Choose File > Preferences. The Preferences dialog appears.
3. Click the Setup tab.
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Autofind Hubs when the AnywhereUSB Manager launches

4. Determine whether you want to automatically minimize the AnywhereUSB Manager when it
launches.
n

Select Start Manager minimized to automatically minimize the
AnywhereUSB Manager when it launches.

n

De-select Start Manager minimized to open the AnywhereUSB Manager when it
launches.

5. Click Save.

Autofind Hubs when the AnywhereUSB Manager launches
You can choose to automatically find Hubs connected to the network when AnywhereUSB Manager
launches.
1. Open AnywhereUSB Manager.
2. Choose File > Preferences. The Preferences dialog appears.
3. Click the Setup tab.
4. Determine whether you want to automatically find Hubs on the network when
AnywhereUSB Manager launches.
n

Select Autofind Hubs to automatically find Hubs on the network. This is the default.

n

De-select Autofind Hubs to ensure that the Hubs are not automatically found. In this
case, you must manually add the Hubs to which you want to connect.

5. Click Save.

Specify search, response, and keepalive intervals for a Hub
You can specify the search and response time for Hubs on the network, and the keepalive intervals for
the connection between the Hub and the AnywhereUSB Manager.
1. Open AnywhereUSB Manager.
2. Choose File > Preferences. The Preferences dialog appears.
3. Click the Advanced tab.
4. Enter the following:
n

Search for Hubs every .... sec: Specifies how often the AnywhereUSB Manager
searches the local network for AnywhereUSB® Plus Hubs..

n

Wait for Hub response for .... sec: Specifies how long the AnywhereUSB Manager
should wait for local Hubs to respond.

n

Send Keep-Alive every ... sec: Specifies how often the AnywhereUSB Manager should
send keepalive messages to the Hubs connected to the network.

n

Keep-Alive Timeout ... sec: Specifies how long the AnywhereUSB Manager should
wait for a keepalive response.

5. Click Save.
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View latency graph

View latency graph
You can review the relative latency of all of the Hubs connected to the network.
1. Open the AnywhereUSB Manager.
2. Select Help > Latency graph to display the latency graph.

View the AnywhereUSB Manager system messages
You can view the system message log of the AnywhereUSB Manager events. The date and time at
which an event occurred is listed, as well as the event type and additional information. A new log is
created each time you start the AnywhereUSB Manager.
The system message log is used for troubleshooting.
1. Open the AnywhereUSB Manager.
2. Select Help > System Messages. The System Messages dialog appears.
n

Click Clear Log to clear the system messages from the log.

n

Click Copy to Clipboard to copy the messages to the Windows clipboard. You can then
paste the messages into another application or document.

3. Click Close to close the System Messages dialog.

View AnywhereUSB® Plus license information
You can view license information about the AnywhereUSB® Plus Hub.
1. Open the AnywhereUSB Manager.
2. Select Help > About. The License dialog appears.
3. Scroll down to review all of the information.
4. Click Close to close the dialog.
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Restore AnywhereUSB Manager default configuration

Restore AnywhereUSB Manager default configuration
You can restore the AnywhereUSB Manager to the default settings. During this process, you have the
option to keep your currently configured client ID and identity certificate during this process. See
Client ID for more information about how the client ID is used by your computer and the Hub to create
a connection.
n Keep the current client ID
n

Change the client ID

Keep the current client ID
To restore the Hub's default settings and keep your currently configured client ID and identity
certificate:
1. Open the AnywhereUSB Manager.
2. Select File > Preferences. The Preferences dialog appears.
3. Click the Setup tab.
4. Click Restore default settings. A dialog appears.
5. Select the Keep Client ID option. This is selected by default.
6. Click OK. The AnywhereUSB Manager closes automatically. The next time you launch the
AnywhereUSB Manager, the default settings will be restored.

Change the client ID
To restore the Hub's default settings and change your currently configured client ID and identity
certificate:
1. Open the AnywhereUSB Manager.
2. Select File > Preferences. The Preferences dialog appears.
3. Click Restore default settings. A dialog appears.
4. De-select the Keep Client ID option.
5. Click OK. The AnywhereUSB Manager closes automatically.
6. Open the AnywhereUSB Manager again. The Client ID confirmation dialog appears.
7. Enter a new, unique client ID.
8. Click OK. The AnywhereUSB Manager launches.

Access the online help from the AnywhereUSB Manager
1. Open the AnywhereUSB Manager.
2. Click Help > Online Manual to launch the online help file.

AnywhereUSB Manager window
The AnywhereUSB Manager displays AnywhereUSB® Plus Hubs, groups, and USB devices. Click the
plus sign next to each name in the window to display a hierarchy of found Hubs, groups, and USB
devices.
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AnywhereUSB Manager window

Information about the icons in the screen and the menu options can be found here:
n AnywhereUSB Manager icons and toolbar
n

AnywhereUSB Manager menu options

You can use the menus associated with the Hubs, groups, and USB devices to configure local names,
preferences, and connections. Right-click on a Hub, group, or device name to display the menus.
n AnywhereUSB Manager Hub menu options
n

AnywhereUSB Manager group menu options

n

AnywhereUSB Manager USB device menu options

Click on a Hub, group, or device name to display information about the selected Hub, group, or device
in the status pane on the right side of the AnywhereUSB Manager.
n AnywhereUSB Manager Hub Status pane
n

AnywhereUSB Manager Group Status pane

n

AnywhereUSB Manager Device Status pane

AnywhereUSB Manager icons and toolbar
This section explains how to use the icons in the AnywhereUSB Manager and what they represent.
The icons in the AnywhereUSB Manager show the status of a Hub.
Icon

Location

Description

Hub

Green lock: Active and secure connection between the Hub and the PC.
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Icon

AnywhereUSB Manager window

Location

Description

Hub

Yellow dot: The PC and Hub are attempting to connect.

Hub

Red X: Connection between the Hub and the PC failed.

The toolbar icons manage the AnywhereUSB Manager dialog.
Icon

Description
Minimizes the AnywhereUSB Manager into the task bar and the notification area of
the task bar.
Maximizes the AnywhereUSB Manager.

Minimizes the AnywhereUSB Manager into the notification area of the task bar.

AnywhereUSB Manager menu options
You can use the menu options to view AnywhereUSB® Plus Hub information.
n File > Preferences
n

File > Exit

n

Configure > Known Hubs

n

Help > System Messages

n

Help > Latency graph

n

Help > Online Manual

n

Help > About

AnywhereUSB Manager Hub menu options
Right-click on a Hub name in the AnywhereUSB Manager to configure and maintain the Hub.
n Open Web UI
n

Assign Local Name

AnywhereUSB Manager group menu options
Right-click on a group name in the AnywhereUSB Manager to configure and maintain the group.
n Connect to Group
n

Disconnect from Group

n

Enable Auto Connect
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n

Disable Auto Connect

n

Assign Local Name

AnywhereUSB Manager window

AnywhereUSB Manager USB device menu options
Right-click on a USB device name in the AnywhereUSB Manager to configure and connect to the USB
device.
n Connect to Device
n

Connect to Group

n

Disconnect from Device

n

Assign Local Name

AnywhereUSB Manager Hub Status pane
When you select an AnywhereUSB® Plus Hub in the AnywhereUSB Manager, information about the
Hub displays in the Hub Status pane.

Label

Description

State

The current state of the Hub. Options are:
n Connecting
n

Authenticating

n

Active (secure): A green lock icon appears next to the Hub
name.

n

Error: If an error has occurred, a red X icon appears next to
the Hub name.

See AnywhereUSB Manager icons and toolbar for more information
about the Hub icons.
Name
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The name of the Hub supplied by the Hub. The default value for the
Hub name is the serial number assigned to the Hub. You can change
the Hub name in the Ethernet Network section of the web UI. See
Rename the Hub.

39

Manage the Hubs using the AnywhereUSB Manager

AnywhereUSB Manager window

Label

Description

Local Name

A descriptive local name for the Hub. The local name also displays in
the tree view in the left-hand pane in the AnywhereUSB Manager.
The local name is local to the computer on which the AnywhereUSB
Manager is running.
You can change the local name using the Assign Local Name menu
option for the Hub.

Model

The model name for the AnywhereUSB® Plus Hub.

Version

The version number of the firmware running on the Hub.

Address

The network address of the Hub.

Serial

The serial number of the Hub, which is found on the Hub label.

AnywhereUSB Manager Group Status pane
When you select a group in the AnywhereUSB Manager, information about the group displays in the
Group Status pane.
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AnywhereUSB Manager window

Label

Description

Group No

The group number from the Hub.

Group Name

The name of the group supplied by the Hub. By default, a group is
named "Group" appended by a consecutive number, such as Group
1, Group 2, and so on.
You can change the group name in the AnywhereUSB screen in the
web UI. See Create groups and assign ports to the group.

Local Name

A descriptive local name for the group. The local name also displays
in the tree view in the left-hand pane in the AnywhereUSB
Manager. The local name is local to the computer on which the
AnywhereUSB Manager is running.
You can change the local name using the Assign Local Name menu
option for the group.

Status

A status message indicates whether a user is currently connected
this group. Options are:
n You are using this group
n

No one is using this group

n

In use by <client ID> at <machine name>

AnywhereUSB Manager Device Status pane
When you select a USB device in a group in the AnywhereUSB Manager, information about the device
displays in the Device Status pane.

Label

Description

Vendor

Name of the USB device vendor, if supplied by the device.

Product

Name of the USB product, if supplied by the device.
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AnywhereUSB Manager window

Label

Description

Local Name

A descriptive local name for the USB device. The local name also
displays in the tree view in the left-hand pane in the AnywhereUSB
Manager. The local name is local to the computer on which the
AnywhereUSB Manager is running.
You can change the local name using the Assign a Local Name
menu option for the device. See Assign a local name to a
USB device.

Vendor ID

The USB vendor ID.

Product ID

The USB product ID.

Address

The USB device address that helps to identify a device.

Serial

The serial number of the USB device, if supplied by the device.

Status

A status message indicates whether a user is currently using this
device. Options are:
n You are using this device
n

No one is using this device

n

In use by <client ID> at <machine name>

Set Hub preferences
In the AnywhereUSB Manager, you can set preferences for keepalive time messages and responses
and how often the AnywhereUSB Manager searches for a Hub and the Hub response time.
Click File > Preferences to display the Preferences dialog.

Setup tab
n

Client ID

n

Start Manager minimized

n

Autofind Hubs

n

Restore default settings
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Exit the AnywhereUSB Manager

Advanced tab
Specify search, response, and keepalive intervals for a Hub

Exit the AnywhereUSB Manager
You can log out of the AnywhereUSB Manager close the dialog.
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Exit the AnywhereUSB Manager

1. Open the AnywhereUSB Manager.
2. Click File > Exit to disconnect all USB devices connected to your computer, close all
connections, and close the AnywhereUSB Manager.
3. If you are connected to any USB devices, a confirmation dialog appears.

4. Click Yes to exit the AnywhereUSB Manager.
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Administrators: Configure the AnywhereUSB® Plus in
the web user interface
You can configure the AnywhereUSB® Plus Hub in the Configuration and Management web user
interface.
The web UI is available from a Hub listed in the AnywhereUSB Manager. You must install the
AnywhereUSB Manager before you can use the web UI. See Install the AnywhereUSB Manager.
Open the Configuration and Management web user interface
Configuration and Management web user interface
Configure and manage client IDs
Automatically register or reject unknown clients
Rename a Hub and the groups in a Hub
View Hub system information
Configure the IP address on the Hub
Ethernet network bonding
Change the Hub password
View current connections to the Hub
Configure network services
Configure the findme feature
Configure device identity settings
Allow the Hub to connect to Remote Manager
Backup and restore settings
Update the firmware
View system logs
View system statistics
Configure the time on the Hub
Restore factory default settings from the web UI
Reboot the Hub
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Open the Configuration and Management web
user interface

Open the Configuration and Management web user interface
You can open the Configuration and Management web user interface for a selected AnywhereUSB®
Plus Hub. The information in the web UI is unique for each Hub. Make sure you select the desired Hub
before you open the web UI.
By default, the Home page appears when you open the web UI for a Hub, and displays current Hub
status information. Click Refresh to update the information displayed in the page.
1. Open the AnywhereUSB Manager.
2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
3. Right-click on the Hub that you want to configure or maintain.
4. Click Open Web UI. The Configuration and Management web user interface appears, and
displays the Home page by default.
Note The first time you launch the web UI, a warning dialog may appear if your internet
connection is not private. In this situation, continue to access the device, and a log in dialog
appears. If your internet connection is private, only the log in dialog appears. The user name is
admin and the default password is located on the label on the bottom of the Hub. Note that
the password is case-sensitive and must be typed in exactly as it appears on the label.
5. Configure or maintain the Hub as needed. See Administrators: Configure the AnywhereUSB®
Plus in the web user interface for more information.
6. When you are done working in the web UI, close the browser window.

Access the online help from the web UI
1. Open the web UI.
2. Click Help > Online Manual to launch the online help file.

Apply and save changes
The web UI runs locally on the device, which means that the interface always maintains and displays
the latest settings for the connected AnywhereUSB® Plus Hub.
When you make a change to the configuration, click Apply to save the changes.

Configuration and Management web user interface
The Configuration and Management web user interface contains a set of pages you can use to
configure and maintain the AnywhereUSB® Plus Hub.
n Home
Configuration section
n Ethernet Network
n

AnywhereUSB

n

Network Services

n

System

n

Time
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n

Remote Manager

n

Admin Password

Configure and manage client IDs

Management section
n Connections
Administration section
n Backup/Restore
n

Firmware Update

n

Factory Default Settings

n

System Log

n

Find Me LED

n

System Statistics

n

Reboot

Help
n

Online Manual

Configure and manage client IDs
The client list for a Hub displays in the Client Settings section. This list contains all of the client IDs for
the computers that are allowed to connect to the Hub. You can manually add client IDs or choose to
automatically add client IDs to the list.
Note You can have up to 24 client IDs in the client list.
The client IDs are assigned to groups of USB ports on the Hub. When a computer connects to a group
in the AnywhereUSB Manager, the computer has access to all of the ports in the group and the
devices connected to those ports. No other computer is allowed to access any of the devices in the
group. A computer can connect to more than one group at a time.
n Configure a client ID
n

Manually add a client ID

n

Remove a client ID

n

Automatically register or reject unknown clients
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Configure and manage client IDs

Configure a client ID
You can assign a descriptive name to a client ID in the client list, and update the groups the computer
is allowed to access. The computer can access all of the ports in the specified groups, as defined in the
Group Settings section.
Note If needed, you can also add additional client IDs to the list.
1. Open the web UI.
2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.
3. In the client list in the Client Settings section, select the client ID that you want to configure.
Information about the selected client ID displays in the Settings for Client section.
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Configure and manage client IDs

4. The Certificate value is Unavailable until certificates have been exchanged between the
computer and the Hub. After this occurs, the Certificate value is updated to Available.
5. In the Description field, enter a descriptive name for the client ID.
6. Click the check box next to a group to which the computer is allowed access. As you select
groups, the selected group numbers appear in the Group Access field in the Settings for
Client section.
You can also manually enter group numbers in the Group Access field.
7. Click Apply to save the changes.

Manually add a client ID
You can manually add client IDs to the client list. When a computer searches for Hubs, any computer
with a client ID on the client list can connect to the Hub.
Note You can have up to 24 client IDs in the client list.
After you have added a client ID, the certificate is unavailable until the first time the computer with
the new client ID connects to the Hub. When the computer connects to the Hub for the first time, the
identity certificates are exchanged between the computer and the Hub. After the initial connection,
only that computer with the client ID and unique identity certificate is able to connect to the Hub. Any
other computer with the same client ID will be rejected. For information about computers with the
same client ID, see AnywhereUSB Manager client ID is not unique.
WARNING! After you have manually added a client ID to the list, Digi recommends that
you use a private network to connect the computer to the Hub and then to verify the
initial connection. If you do not use a private network, and the same client ID is assigned
to both a known and an unknown computer, there is a risk of misidentification. In this
situation, an unknown computer may connect to the Hub before the known computer
does, resulting in the wrong computer being allowed to connect to your Hub.
Note Digi recommends de-selecting the Automatically Register Unknown Clients option if you
choose to manually add multiple client IDs to the client list. See Automatically reject unknown clients.
1. Open the web UI.
2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.
3. In the Client Settings section, click Add Client. A new row labeled "New Client" is added to
the client list and the Settings for Client section is populated for the new client.
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4. Enter information about the client ID in the Settings for Client "New Client" section.
a. In the Client ID field, enter the client ID for the computer.
b. In the Description field, enter a descriptive name for the client ID.
c. Click the check box next to a group to which the computer is allowed access. As you
select groups, the selected group numbers appear in the Group Access field in the
Settings for Unknown Clients section.
Note The Certificate value is Unavailable until certificates have been exchanged between the
computer and the Hub. After this occurs, the Certificate value is updated to Available.
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5. Click Apply. The client ID is added to the client list.

Remove a client ID
You can remove a client ID from the client list when that computer should no longer have access to
the Hub.
Note If you have selected the Automatically Register Unknown Clients option, any client ID
removed from the list is automatically added to the client list again the next time the computer tries
to connect.
1. Open the web UI.
2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.
3. In the Client Settings section, select the client ID you want to remove from the list.
4. Click Remove. A confirmation dialog appears..
5. Click OK.

Automatically register or reject unknown clients
In the AnywhereUSB Configuration page, you have the choice to automatically register or reject
computers that have not previously connected to the Hub. The Automatically Register Unknown
Clients option is disabled by default, meaning that computers that have not previously connected to
the Hub are rejected.
Note Digi recommends keeping the Automatically Register Unknown Clients option disabled and to
manually add client IDs on a secure network.
n

Automatically reject unknown clients

n

Automatically register unknown clients

Automatically reject unknown clients
You can choose to have the Hub automatically reject any client ID that is not on the Hub's registered
client list.
You can view which When you open the AnywhereUSB Manager, the Hub is found on the network, but
a red X displays next Hub name, as the client ID is not registered with the Hub. The user is not able to
connect to the Hub.
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Note Digi recommends keeping the Automatically Register Unknown Clients option disabled and to
manually add client IDs on a secure network.
1. Open the web UI.
2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.
3. De-select the Automatically Register Unknown Clients option so the Hub rejects any client
ID that is not on the Hub's registered client list. In this case, a red X displays next to the name
of the Hubs in the AnywhereUSB Manager to which the client ID cannot connect.
4. Click Apply to save the changes.

Automatically register unknown clients
Select the Automatically Register Unknown Clients option to automatically add the client ID for an
unknown computer to the client list for the Hub. When you open the AnywhereUSB Manager and the
Hub is found on the network, and the user is able to automatically connect to the Hub.
By default, the computer will have access to the ports in the groups specified in the Group Access
field in the Settings for Unknown Clients section. The ports for each group are specified in the Group
Settings section. You can change the groups to which a computer has access in the Client Settings
section.
A user will be able to connect to the Hub in the AnywhereUSB Manager.
1. Open the web UI.
2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.
3. Select the option to automatically add the client ID for an unknown computer to the client list
for the Hub.
4. Click the check box next to the group(s) to which the computer is allowed access. As you select
groups, the selected group numbers appear in the Group Access field in the Settings for
Unknown Clients section.
You can also manually enter group numbers in the Group Access field.
5. Click Apply to save the changes.

Rename a Hub and the groups in a Hub
A default name is assigned to a Hub and to the groups in the Hub. These names are associated with
the physical Hub and groups on the Hub, and can be changed in the Configuration and Management
web user interface.
Note A USB device does not have a name that can be changed. However, a local name can be
assigned to a USB device in the AnywhereUSB Manager. See Assign a local name to a USB device.
The default Hub name and group name can be see by every user that connects to the Hub. You can
also give a Hub and groups a local name that can be see only by the user that assigns the name. See
Assign a local name to a Hub and Assign a local name to a group.
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Note Only administrators can rename the Hubs and the groups.
n

Rename the Hub

n

Rename a group

Rename the Hub
You can rename the AnywhereUSB® Plus Hub in the Ethernet Network Configuration page.
By default, the Hub name is the serial number assigned to the Hub. The serial number for the Hub is
on the Hub's label. The Hub name displays in the Name field in the Hub Status pane in the
AnywhereUSB Manager.
Note The name can consist of the following characters: 0-9, A-Z, a-z, dash (-), or period (.). You cannot
use spaces, underscores (_), comma (,), forward slash (/), or ampersand (&).
1. Open the web UI.
2. Select Ethernet Network from the Configuration section. The Ethernet Network
Configuration dialog appears.
3. In the Host Name field, enter a descriptive name for the Hub. The name cannot have spaces or
underscores.
4. Click Apply.

Rename a group
You can rename the AnywhereUSB® Plus Hub in the AnywhereUSB page in the web UI.
By default, a group is named "Group" appended by a consecutive number, such as Group 1, Group 2,
and so on. The group name displays in the Group Name field in the Group Status pane in the
AnywhereUSB Manager.
1. Open the web UI from your selected Hub.
2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.
3. Enter a new name for a group in the Group Description field.
4. Click Apply to save the changes.

View Hub system information
You can view current status information about the Hub in the System Information page. This page
appears by default when you launch the web UI.
The Description, Contact, and Location fields are populated after you have entered identity settings
in the System Configuration page. See Configure device identity settings.
1. Open the web UI. This page appears by default when you launch the web UI.
2. Click Home. The System Information page appears.
3. Click Refresh to update the information in the page.
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Configure the IP address on the Hub
You can configure the IP address for the Hub in the Ethernet Network Configuration page. You can
choose to enable the Hub to automatically obtain an IP address, or you can manually assign an IP
address.
n Automatically obtain an IP address for the Hub
n

Manually set an IP address for the Hub

Automatically obtain an IP address for the Hub
In the Ethernet Network Configuration page, you can configure the Hub to automatically obtain an
IP address each time you power on the Hub.
The Obtain an IP address automatically using DHCP option is enabled by default. DHCP is used to
automatically assign IP addresses; deliver TCP/IP stack configuration parameters, such as the subnet
mask, default gateway and domain name servers; and to provide other configuration information.
When the Obtain an IP address automatically using DHCP option is enabled, but if the DHCP server
is unavailable or nonexistent, Auto-IP assigns the device an IP. Auto-IP (Auto Private IP Addressing
(APIPA)), is a standard protocol that automatically assigns an IP address from a reserved pool of
standard Auto-IP addresses to the computer on which it is installed. If DHCP is enabled or responds
later, the IP address assigned by DHCP overrides the Auto-IP address that was previously assigned.
Note If the Obtain an IP address automatically using DHCP option is disabled, the Use the
following IP address option is enabled by default, and you must manually set an IP address.
1. Open the web UI.
2. Select Ethernet Network from the Configuration section. The Ethernet Network
Configuration dialog appears.
3. Select the Obtain an IP address automatically using DHCP option.
4. The values in the Primary DNS and Secondary DNS fields are automatically assigned.
5. Click Apply.

Manually set an IP address for the Hub
You can manually assign a specific IP address for the AnywhereUSB® Plus Hub in the Ethernet
Network Configuration page.
1. Open the web UI.
2. Select Ethernet Network from the Configuration section. The Ethernet Network
Configuration dialog appears.
3. Select the Use the following IP address option.
4. Enter the appropriate values in the IP Address, Subnet Mask, and Default Gateway fields.
5. Enter the appropriate values in the Primary DNS and Secondary DNS fields.
6. Click Apply.
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Ethernet network bonding
For the AnywhereUSB 24 Plus Hub, you can specify the bonding mode for the Ethernet network. The
Hub has two physical Ethernet network ports that use the same MAC address and share one IP
address. When both ports are being used, they act as one Ethernet network port.
Note This does not apply to the AnywhereUSB 2 Plus or 8 Plus Hubs.
1. Open the web UI.
2. Select Ethernet Network from the Configuration section. The Ethernet Network
Configuration dialog appears.
3. In the Ethernet Network Bonding section, select the bonding option that you want to use.
Bonding is used when Ethernet cables are connected to both Ethernet network ports.
n

Load Balancing (Round-Robin): The Ethernet network connection alternates between
the two ports as the Hub sends data. If one Ethernet network connection fails, all data
is sent from the second Ethernet network connection.

n

Fault-Tolerance (Active-Backup): The Hub uses only one of the Ethernet network
connections at a time. If one Ethernet network connection fails, all data is sent from the
second Ethernet network connection. This is the default.

4. Click Apply.

Change the Hub password
You can change the administrator password for the Hub in the Admin Password Management page.
Note The default password is included on the Hub's label, and must be entered the first time you
connect to the Hub from the web UI.
After you change the password, you must log in before you can access any pages in the web UI.
1. Open the web UI.
2. Click Admin Password in the Configuration section. The Admin Password Management page
appears.
3. In the Current Password field, enter the current password.
4. In the New Password field, enter the new password.
5. In the Confirm Password field, re-enter the new password.
6. Click Apply to apply and save the change.
7. Select any link in the web UI. A log in dialog appears.
8. Log in using the new password.
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View current connections to the Hub
You can view information about current connections to the Hub in the Connections Management
page.
1. Open the web UI.
2. Click Connections in the Management section. The Connections Management page appears.
n

Local Address: The IP address of the Hub and the TCP port number of a network
service running on the Hub. The TCP Port information is available on the Network
Service Configuration page.

n

Remote Address: The IP address of the computer connected to the Hub.

n

Service: A description of the service connected to the Hub.

3. Click Refresh to update the information in the screen.

Configure network services
You can configure network services options in the Network Service Configuration page. All network
services options are selected by default.
For each service you must specify the TCP port number. The ports are configured by default, and
changing the default value is not recommended.
1. Open the web UI.
2. Click Network Services in the Configuration section. The Network Service Configuration
page appears.
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3. Select the Enable option for the network service you want to enable.
n

Multicast Domain Name System (MDNS): Enables the discovery of the Hub on the local
network.

n

Enable AnywhereUSB: Allows remote access to USB devices connected to this server.
The default TCP Port value is 18574.

n

Enable Secure Shell Server (SSH): Allows users secure access to log in to the Digi
device and access the command line interface. The default TCP Port value is 22.

n

Enable Web Server (HTTP): Enables web pages for configuration. The default TCP Port
value is 80.

n

Enable Secure Web Server (HTTPS): Enables web page encryption to improve the
security of web data transfers. The default TCP Port value is 443.

4. Enter the port number in the TCP Port field. If you change the port number on this screen, you
must also change the corresponding port number on your computer.
5. Click Apply to apply and save the changes.

Configure the findme feature
You can use the findme feature to cause an LED on the Hub to blink, which can help you to identify a
specific Hub.
n AnywhereUSB 2 Plus: When enabled, the power LED blinks blue, then orange.
n

AnywereUSB 8 Plus and AnywhereUSB 24 Plus: When enabled, the user LED blinks green,
then orange.

Note You can also configure this feature using the findme CLI command.
1. Open the web UI.
2. Click Find Me LED in the Administration section. The Find Me LED page appears.

3. Click Activate. The "Find Me LED Status" message changes to blinking, and the message "The
Find Me LED is blinking" appears at the top of the page. The appropriate LED on the Hub begins
to blink.
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4. When you have found the Hub, click Stop. The "Find Me LED Status" message changes to not
blinking, and the message "The Find Me LED is stopped" appears at the top of the page.

Configure device identity settings
You can configure the device description, contact, and location information for the Hub in the System
Configuration page. This feature is useful to identify a specific Hub when working with a large
number of Hubs in multiple locations. The information entered on this page appears in the Home
page.
1. Open the web UI.
2. Click System from the Configuration section. The System Configuration page appears.
3. Enter the following information:
n

Description: An identifying description of the Hub.

n

Contact: Any contact information for a person that can manage the Hub, such as the
administrator name and contact information.

n

Location: The physical location of the Hub.

4. Click Apply to apply and save the changes.

Allow the Hub to connect to Remote Manager
You can use Digi® Remote Manager to view your Hubs and manage the information sent from the Hub
to Remote Manager. By default, the Hub is configured to connect to Remote Manager, and Remote
Manager is configured to allow a connection with the Hubs.
You can enable access for the Hub to Remote Manager and specify reconnect time and keepalive
intervals in the Remote Manager Configuration page. You can view information about the connection
to Remote Manager in the System Statistics page and in the Connections Management page.
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Note You must have a Remote Manager account and add the Hub to Remote Manager to be able to
view the Hub data in Remote Manager. For more information, see View Hub information in Remote
Manager.
To enable access to Remote Manager for the Hub:
1. Open the web UI.
2. Click Remote Manager in the Configuration section. The Remote Manager Configuration
page appears.
3. Select Enable Remote Manager Connectivity. This option is selected by default.
4. In the Remote Manager Server field, enter the name of your Remote Manager server. A value
is entered by default.
5. Enter the following information:
n

Reconnect Time: The amount of time to wait after the Hub has been disconnected from
Remote Manager before the Hub should automatically try to reconnect. The time is
measured in seconds. The default is 30 seconds.

n

Device keepalive interval: The interval at which the Hub sends a keep-alive packet to
Remote Manager if the Remote Manager connection is idle. Remote Manager expects
to receive either Remote Manager protocol messages or keep-alive packets at the
specified interval. The time is measured in seconds. The default is 60 seconds.

n

Server keepalive interval: The interval at which Remote Manager sends a keep-alive
packet to the Hub if the Remote Manager connection is idle. The Hub expects to receive
either Remote Manager protocol messages or keep-alive packets at the specified
frequency. The time is measured in seconds. The default is 60 seconds.

n

Maximum missed keepalives: The number of consecutive keep-alives can be missed
before the connection between Remote Manager and the Hub is considered lost and
subsequently closed by the Hub and Remote manager. The default is 3.

6. Click Apply to apply and save the change.
7. To ensure your connection to Remote Manager, see View Hub information in Remote Manager
for details about adding the Hub to Remote Manager.

Backup and restore settings
The backup and restore feature allows you to save any configuration changes you have made to a file,
and then restore a configuration by applying the saved changes to any Hub.
n Backup: The back up file contains only the configuration changes you have made from the
default settings. The entire configuration of a Hub is not saved.
n

Restore: When you restore a configuration, the changes saved to the backup file are applied
over any other existing changes on the Hub.

When configuration of a Hub is complete, it is recommended that you back up that configuration in
case you need to revert to a desired configuration.
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You can also use the backup/restore feature as a convenience when configuring multiple Hubs. You
can back up the first Hub's configuration settings, and then apply that back up file to other Hubs.
The format of the back up file is a list of CLI commands.

Back up a Hub's configuration
Only the changes made from the default configuration are saved to the back up file.
1. Open the web UI.
2. Click Backup/Restore from the Administration section. The Backup/Restore page appears.
3. Click Backup to back up the Hub's current configuration to a back up file.
4. A confirmation dialog appears. Save the change to continue.

Restore the configuration for a Hub
You can apply a previously saved backup file from a Hub to the same Hub or any other Hub.
Note The backed up changes are applied on top of the current settings for the Hub.
1. Open the web UI.
2. Click Backup/Restore from the Administration section. The Backup/Restore page appears.
3. Click Choose File to select a backup file that you previously saved.
4. Click Restore to apply the selected backup file to the Hub.

Update the firmware
You can update the firmware on a Hub from the Update Firmware page. Information about the
current version of the firmware appears in the screen.
You must first get the current firmware file, and then you can upload it to the Hub.

Download the firmware to your computer
1. Go to www.digi.com/support.
2. Scroll down to the Support Downloads section.
3. Click Firmware Updates.
4. In the Filter the list box, enter AnywhereUSB Plus. As you type, matches display.
5. Click AnywhereUSB Plus.
6. From the list of options, select the option for your model: AnywhereUSB 2 Plus,
AnywhereUSB 8 Plus, or AnywhereUSB 24 Plus.
7. From the Firmware Updates section, select the version you want to download. The file is
downloaded to a folder on your computer. Make a note of the folder path and name.
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Update the firmware on the Hub
1. Open the web UI.
2. Click Firmware Update from the Administration section. The Update Firmware page appears.
3. Click Choose File and browse for the firmware file.
4. Click Update. When the update is complete, a status message appears.

Note DO NOT close the browser until the update is complete and the status message appears.
5. The device automatically reboots. When the reboot is complete, all the LEDs light up.

View system logs
You can view information from the device log files in the System Message Log File Browser screen.
The log files are mainly used for troubleshooting.
1. Open the web UI.
2. Click System Log in the Administration section. The System Message Log File Browser page
appears.
3. From the Select Log File list box, select the log file that you want to view. The eventlog.txt file
is selected by default.
4. Click Get File. The messages in the log file display in the Messages in Log File section.
5. The filters that relate to the log file option you selected appear in the Messages in Log File
section. All filters are selected by default. You can:
n

Select and de-select individual filters.

n

Click Clear All to de-select all of the filters.

n

Click Mark All to select all of the filters.

As you select and de-select filters, the Message Filters for Displayed Log File section is
updated.
6. Click Refresh to update the messages that appear in the Message Filters for Displayed Log
File section.
7. Click Save All to save the messages in a .txt file. The file is downloaded so you can access the
file.

View system statistics
The System Statistics page displays statistical information for these connections: ethernet, IP, TCP,
UDP, and ICMP. Remote Manager connection information is also displayed.
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1. Open the web UI.
2. Click System Statistics in the Administration section. The System Statistics page apears.
3. Click Refresh to update the information.

Configure the time on the Hub
In the Time Configuration page, you can choose to either manually set the time on the Hub to match
the time on the server, or to configure time server synchronization.
To access this page from the web UI, click Time in the Configuration section.
n Configure time server synchronization: Use this method to synchronize the time on the Hub
with the NTP (Network Time Protocol) servers.
n

Set the server time manually: Use this method to manually set the time for the Hub. This
overrides the NTP time synchronization.

Configure time server synchronization
You can use this method to synchronize the time on the Hub with the NTP (Network Time Protocol)
servers. This method is the default, and the information for the NTP servers is configured by default.
Note Digi recommends using NTP.
1. Open the web UI.
2. Click Time in the Configuration section. The Time Configuration page appears.
3. Select Enable Time Server Synchronization. This option is selected by default.
4. From the Timezone drop-down, select the time zone the server is in.
5. Click Apply to apply and save the change.

Set the server time manually
You can use this method to manually set the time for the Hub. This overrides the NTP time
synchronization. See Configure the time on the Hub.
If you use this method, and the Hub has lost power (both external and internal), or if you reboot the
Hub, you will need to manually reset the time.
Note Digi recommends using NTP. See Configure time server synchronization.
To manually set the time:
1. Open the web UI.
2. Click Time in the Configuration section. The Time Configuration page appears.
3. Select Set Time in the Time Settings section.
4. Specify the current date and time for the server in the Month, Day, Year, Hour, Minute, and
Second fields.
5. From the Timezone drop-down, select the time zone the server is in.
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6. Click Apply to apply and save the change.

Restore factory default settings from the web UI
You can use the Factory Default Settings operation from the web UI to reset the configuration of a
Hub to the factory default settings. The restore process clears all current settings (including all
previously stored client IDs and certificates), deletes all Hub and AnywhereUSB Manager keys, resets
the password for the administrative user, and restores the settings to the factory defaults.
When restoring the Hub to the factory defaults from the web UI, you can choose to retain the stored
IP configuration, which is configured on the Ethernet Network Configuration page.
Note You can also use the factory-default CLI command for all Hub models, and the Reset button on
the Hub to restore the factory default settings. Note that these methods do not allow you choose
whether you want to retain the stored IP configuration.
1. Open the web UI.
2. Make a backup copy of the configuration using the Backup/Restore operation to save the
current configuration in case you want to restore it at a later time.
3. Click Factory Default Settings from the Administration section. The Factory Default Settings
page appears.
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4. Determine whether you want to retain the current DHCP and manual configuration settings. IP
configuration option: automatic (automatically obtain an IP address each time you power on
the Hub) or static (manually assign an IP address).
n

Do not select the Keep Stored IP Configuration option to remove the current IP
configuration option. In this situation, the DHCP (Auto IP) process is used. For more
information about DHCP and Auto IP, see Automatically obtain an IP address for the
Hub. This is the default.

n

Select the Keep Stored IP Configuration option to retain the current IP configuration
option. The IP, netmask, gateway, and DNS values will be used for the network
configuration. These manual values are kept in the configuration settings even if you
are currently using DHCP, so you can flip back and forth.

5. Click Restore. The Hub is rebooted.
6. You must re-deploy the Hub.

Reboot the Hub
You can reboot the Hub if needed. For example, changes to some Hub settings require saving the
changes and rebooting the Hub for the changes to take effect on the Hub.
1. Open the web UI.
2. Select Reboot from the Administration section. The System Reboot Confirmation page
appears.
3. Click Reboot.
4. Wait approximately 15 seconds for the reboot to complete. When the reboot is complete, all
the LEDs turn on and then turn off, leaving the power LEDs on. For the AnywhereUSB 24 Plus
model, one or both of the power LEDs will be on.
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By default, an AnywhereUSB® Plus Hub is configured to allow a connection between the Hub and
Remote Manager.
n For information about enabling a Hub to connect to Remote Manager, see Allow the Hub to
connect to Remote Manager for more information.
n

For information about accessing Remote Manager and adding a Hub to Remote Manager, see
Get started with Remote Manager.

For more information about Remote Manager in general, see the Digi Remote Manager User Guide.

Get started with Remote Manager
Before you can access an AnywhereUSB® Plus Hub in Remote Manager, you must be able to access
your account in Remote Manager, and then add the Hub to the list of devices that are monitored by
Remote Manager.
1. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.
2. Add the Hub to the list of devices monitored by Remote Manager.
For more detailed information about using Remote Manager, see the Digi Remote Manager User Guide.

Update the firmware on the Hub from Remote Manager
You can update the firmware on an AnywhereUSB® Plus Hub from Remote Manager. You must first get
the current firmware file, and then you can upload it to the device.
1. Download the firmware to your computer.
2. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.
3. Click Device Management.
4. From the list of devices, click on the Hub for which you want to update the firmware.
5. In the toolbar, click More > Update Firmware. The Update Firmware dialog appears.
6. Click Browse to select the firmware file you just downloaded.

AnywhereUSB® Plus User Guide

65

View Hub information in Remote Manager

View identifying information about the Hub on the Home page

7. Click Update Firmware to immediately update the firmware. The updated Hubs will
automatically reboot when the updates are complete.
Note By default, the firmware will update when you click the Update Firmware button. If you
want to schedule when you want the update to occur, click the gear icon to display the options.
See Schedule an action in the Digi Remote Manager User Guide for detailed information about
the schedule options.

View identifying information about the Hub on the Home page
You can display information about the Hub in the Home page, such as the IP address, global address,
and the Hub device ID. From this page you can also view the Hub data stream and device file.
1. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.
2. Click Device Management.
3. From the list of devices, click on the AnywhereUSB® Plus Hub for which you want to view
identifying information.
4. Click Properties in the toolbar. The Home page for the Hub appears.

View Hub summary dashboard
Remote Manager tracks connection history between an AnywhereUSB® Plus Hub and Remote
Manager. You can a graph of the connection information. See View Hub connection history for detailed
information.
1. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.
2. Click Device Management.
3. From the list of devices, click on the AnywhereUSB® Plus Hub for which you want to view
connection history.
4. Click Properties in the toolbar. The Home page for the Hub appears.
5. Click Summary Dashboard in the left pane. The connection history graph for the Hub displays.

View Hub connection history
Remote Manager tracks and displays a detailed connection history between an AnywhereUSB® Plus
Hub and Remote Manager. You can view connection and disconnection times, connection methods,
and disconnect reasons. See View Hub summary dashboard for a graph of the connection history.
1. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.
2. Click Device Management.
3. From the list of devices, click on the AnywhereUSB® Plus Hub for which you want to view
connection history.
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4. Click Properties in the toolbar. The Home page for the Hub appears.
5. Click Connection History in the left pane. The connection history for the Hub displays.
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This chapter explains how to configure the AnywhereUSB from the command line interface (CLI).
Configuring an AnywhereUSB through the CLI consists of entering a series of commands to set values
in the device.
Access the command line interface
?
backup
display cloud
display device
display route
display tcp
display udp
display versions
exit
factory-default
findme
fwupdate
help
info ethernet
info icmp
info ip
info tcp
info udp
newpass
quit
reboot
revert
set cloud
set host
set network
set service
set system
set time
set usbclient
set usbgroup
show
who
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Access the command line interface
To configure devices using the command line interface:
1. Do one of the following to connect the AnywhereUSB to a computer.
n

Using a serial port on the AnywhereUSB 8 Plus or Anywhere USB 24 Plus only: Connect
an RS-232 null modem cable between the Console port of the Hub and a PC or laptop
serial port, allowing CLI access directly through a Terminal emulation program. If your
computer doesn't have a serial port, you can use a USB serial adapter. Use the following
serial settings:

n

l

Baud rate or Bits per second: 115200

l

Data: 8 bit

l

Parity: None

l

Stop: 1 bit

l

Flow control: none

Using SSH for all AnywhereUSB® Plus models:
Open a terminal emulation program that supports SSH and connect to the IP
address assigned to the Hub.

2. The login prompt appears. Enter the user ID and password.
n

user ID: admin

n

password: The default password is found on the label of your Hub.

Note If you are unable to log in to your Hub, see Use the Reset button to restore factory
defaults for instructions on restoring the default password.
3. After you have successfully accessed the command line, the #> prompt is displayed.

Abbreviating Commands
You can abbreviate all commands by typing enough letters to uniquely identify the command.
Most terminal emulators use the following keyboard commands:
n Up arrow (or Ctrl-P)/Down arrow(or Ctrl-N) redisplays a few most recent commands. You can
execute one again with the Enter key.
n

Backspace/Ctrl-H key deletes characters to the left of the cursor.

n

Ctrl-B moves the cursor one character to the left within the line. Characters are inserted to the
left of the cursor when typed.

n

Ctrl-F moves the cursor one character to the right within the line. Characters are inserted to
the left of the cursor when typed.

n

The entire line is evaluated when Enter (Ctrl-M or Ctrl-J) is pressed, to the left and right of the
cursor.

n

Ctrl-C cancels the line and gives a new prompt.

n

Ctrl-D closes the CLI session.
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Syntax Conventions
Presentation of command syntax in this manual follows these conventions:
n Brackets [ ] surround optional material.
n

Braces { } surround entries that require you to chose one of several options, which are
separated by the vertical bar, |.

n

Non-italicized text indicates literal values, that is, options or values that must be typed exactly
as they appear. Yes and no options are examples of literals.

n

Italicized text indicates that a type of information is required in that option. For example,
filename means that the name of a file is required in the option.
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?

?
Purpose
Displays options for the current line or command.

Syntax
#> ?

Options
None.

Examples
Display root commands
#> ?
backup
fwupdate
newpass
set

display
exit
quit
show

factory-default
help
reboot
who

findme
info
revert
?

Display options for the set command
#> set ?
syntax: set [options...]
cloud
host
network
usbgroup

service

system

time

usbclient

Display options for the net command
#> set net ?
syntax: set network [options...]
options:
globalsettings
ip=(ipaddr)
submask=(subnet mask)
gateway=(gateway ipaddr)
dhcp=(on|off)
dns1=(primary dns server ipaddr)
dns2=(secondary dns server ipaddr)
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backup
Purpose
Save any configuration changes you have made to a file, and then restore a configuration by applying
the saved changes to any Hub.
This can also be done from the web UI. See Backup and restore settings for more detailed
information.

Syntax
backup [to=serveripaddress[:filename]]|
[from=serveripaddress[:filename]]|
[print]

Options
to=serveripaddress[:filename]
Stores the configuration file to the specified TFTP server and filename. A local file for [filename] may
be selected by specifying "local" as the [serveripaddress] value. If a filename is not specified, the
command uses the default filename of backup.cfg.

from=serveripaddress[:filename]
Restores the configuration file from the specified TFTP server and filename. A local file for [filename]
may be selected by specifying "local" as the [serveripaddress] value. If a filename is not specified, the
command assumes the default filename of backup.cfg.

from=term
Restores the configuration file from the terminal application. Press Ctrl-D at the end of input.

print
Prints out the current device configuration.

Example
#> backup from=10.0.0.1:config.cfg
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display cloud

display cloud
Purpose
Displays the status of the connection to Remote Manager.

Syntax
display cloud

Examples
#> display cloud
Device Type
Device ID
Status
Server
Connection Type
Connection Method
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:
:
:
:
:
:

AnywhereUSB 2 Plus
00000000-00000000-00409DFF-FF3C5C05
Connected to 52.73.177.207:3199 from 10.10.12.14:48288
remotemanager.digi.com
Device-initiated
TCP/SSL
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display device

display device
Purpose
Displays general product information.
This information can also be displayed in the web UI. For more information, see Configuration and
Management web user interface.

Syntax
display device
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display route

display route
Purpose
Displays Route Table entries.

Syntax
display route

Examples
#> display route
Kernel IP routing table
Destination
Gateway
0.0.0.0
10.10.12.1
10.10.12.0
0.0.0.0
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Genmask
0.0.0.0
255.255.255.0

Flags Metric Ref
UG
10
0
U
0
0

Use Iface
0 eth0
0 eth0
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display tcp

display tcp
Purpose
Displays active TCP sessions and active TCP listeners. display tcp provides current TCP information.

Syntax
display tcp

Examples
#> display tcp
Active Internet connections (only servers)
Proto Recv-Q Send-Q Local Address
tcp
0
0 0.0.0.0:18574
tcp
0
0 0.0.0.0:80
tcp
0
0 0.0.0.0:22
tcp
0
0 0.0.0.0:443
tcp6
0
0 :::22
Active Internet connections (w/o servers)
Proto Recv-Q Send-Q Local Address
tcp
0
0 10.10.12.14:48288
tcp
0
0 10.10.12.14:18574
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Foreign Address
0.0.0.0:*
0.0.0.0:*
0.0.0.0:*
0.0.0.0:*
:::*

State
LISTEN
LISTEN
LISTEN
LISTEN
LISTEN

Foreign Address
52.73.177.207:3199
10.10.12.12:36634

State
ESTABLISHED
ESTABLISHED

76

Configure from the command line

display udp

display udp
Purpose
Displays current UDP listeners. display udp provides current UDP information.

Syntax
display udp

Examples
#> disp udp
Active Internet connections (only servers)
Proto Recv-Q Send-Q Local Address
udp
0
0 0.0.0.0:5353
udp
0
0 127.0.0.1:323
udp
0
0 0.0.0.0:43850
udp6
0
0 ::1:323
Active Internet connections (w/o servers)
Proto Recv-Q Send-Q Local Address
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Foreign Address
0.0.0.0:*
0.0.0.0:*
0.0.0.0:*
:::*

State

Foreign Address

State
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display versions

display versions
Purpose
Displays EOS firmware version information.

Syntax
display versions
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exit

exit
Purpose
Logs you out of the Hub.

Syntax
exit
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factory-default

factory-default
Purpose
Restore the AnywhereUSB® Plus Hub to the factory default configuration. The restore process clears
all current settings (including all previously stored client IDs and certificates), deletes all Hub and
AnywhereUSB Manager keys, resets the password for the administrative user, and restores the
settings to the factory defaults. After the Hub reboots, you must re-deploy the Hub.
Note You can also restore the Hub to the factory default settings from the web UI and the Reset
button on the Hub. The Reset button has the same action as the factory-default command. However,
if you restore the Hub to the factory defaults from the web UI, you have the option to retain the IP
address configuration option.

Syntax
factory-default
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findme

findme
Purpose
Turns on/off an LED to aid in finding a specific Hub among a group of Hubs.
n AnywhereUSB 2 Plus: When enabled, the power LED blinks green, then orange.
n

AnywereUSB 8 Plus and AnywhereUSB 24 Plus: When enabled, the user LED blinks green,
then orange.

Note You can also configure this feature on the Find Me page in the web UI.

Syntax
findme [option]

Options
enable={on|off}
Causes the Locator LED to blink or stop blinking.
on
Causes the Locator LED to blink.
off
Causes the Locator LED to stop blinking.

Example
Display the current state of the Locator LED
#> findme

Cause the Locator LED to blink
#> findme enable=on
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fwupdate

fwupdate
Purpose
Updates the firmware on the Hub. The Hub reboots when the firmware update is complete.

Syntax
fwupdate [host]:[filename]

A local file for [filename] may be selected by specifying "local" as the [host] value.
The [host] is the literal "local" or a hostname or IP Address of the TFTP host that can serve this file.

Example
Load new firmware from local file update.bin.
#> fwupdate local:update.bin

Load new firmware from locale file AW08_firmware_A.bin
#> fwupdate 1.2.3.4:AW08_firmware_A.bin
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help

help
Purpose
Displays the commands that are available and the options available for a specific command.

Syntax
help
help [command]

Example
#> help
backup
fwupdate
newpass
set

display
exit
quit
show

factory-default
help
reboot
who

findme
info
revert
?

#> help set
syntax: set [options...]
cloud
usbclient

host
network
usbgroup

service

system

time

#> help set net
syntax: set network [options...]
options:
globalsettings
ip=(ipaddr)
submask=(subnet mask)
gateway=(gateway ipaddr)
dhcp=(on|off)
dns1=(primary dns server ipaddr)
dns2=(secondary dns server ipaddr)

AnywhereUSB® Plus User Guide

83

Configure from the command line

info ethernet

info ethernet
Purpose
Displays Ethernet communications-related statistics.
Statistics that display are gathered since the statistic tables were last cleared by rebooting the Hub,
and include data, event, and error counts. These statistics are useful in understanding how the Hub is
operating and can be helpful in finding problems. In particular, if an error counter is found to be
increasing there may be a problem with the Hub.
To reset the statistics, reboot the device.

Syntax
info ethernet

Examples
#> info eth
Ethernet Statistics:
Bytes Received
Unicast Packets Received
Receive Errors
Received Packets Dropped
Multicast Packets Received

AnywhereUSB® Plus User Guide

:
:
:
:
:

49094876
325217
0
0
0

Bytes Sent
Unicast Packets Sent
Send Errors
Sent Packets Dropped

:
:
:
:

177210984
155961
0
0
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info icmp
Purpose
Displays statistics related to Internet Control Message Protocol (ICMP) activity.
Statistics that display are gathered since the statistic tables were last cleared by rebooting the Hub,
and include data, event, and error counts. These statistics are useful in understanding how the Hub is
operating and can be helpful in finding problems. In particular, if an error counter is found to be
increasing there may be a problem with the Hub.
To reset the statistics, reboot the device.

Syntax
info icmp

Example
#> info icmp
ICMP Statistics:
Datagrams Received
Receive Errors
Unreachable Received
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: 0
: 0
: 0

Datagrams Sent
Send Errors
Unreachable Sent

: 0
: 0
: 0
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info ip

info ip
Purpose
Displays statistics relating to Internet Protocol (IP) activity.
To reset the statistics, reboot the device.

Syntax
info ip

Example
#> info ip
IP Statistics:
Datagrams Received
Header Errors Received
Address Errors Received
Unknown Protos Received
Received Discarded
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:
:
:
:
:

201797
0
10
0
0

Datagrams Sent
Datagrams Forwarded
Send No Route
Send Discarded
Fragments Created

:
:
:
:
:

54487
0
0
0
0
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info tcp
Purpose
Displays statistics relating to Transmission Control Protocol (TCP) activity. Statistics displayed are
those gathered since the statistic tables were last cleared by rebooting the Hub, and include data,
event, and error counts. These statistics are useful in understanding how the Hub is operating and can
be helpful in finding problems. In particular, if an error counter is increasing there may be a problem
with the Hub.
To reset the statistics, reboot the device.

Syntax
info tcp

Example
#> info tcp
TCP Statistics:
Segments Received
Currently Established
Passive Opens
Receive Errors
Established Resets
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:
:
:
:
:

94106
2
2907
0
4

Segments Sent
Segments Retransmitted
Active Opens
Attempt Fails
Resets Sent

:
:
:
:
:

147569
213
1
0
1
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info udp
Purpose
Displays statistics for User Datagram Protocol (UDP) communications activity.
To reset the statistics, reboot the device.

Syntax
info udp

Example
#> info udp
UDP Statistics:
Datagrams Received
Receive Errors
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: 13877
: 0

Datagrams Sent
No Ports

: 2665
: 0
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newpass

newpass
Purpose
Creates or changes administrator password for the Hub.
You can also change the password in the web UI. See Change the Hub password.

Syntax
newpass

You are asked for the current password, the new password, and then to repeat new password.

Examples
#> newpass
changing password for user admin
current password:
new password:
repeat new password:

AnywhereUSB® Plus User Guide

89

Configure from the command line

quit

quit
Purpose
Logs you out of the Hub.

Syntax
quit

Example
#> quit
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reboot

reboot
Purpose
Reboots the Hub.
Note You can also reboot the Hub from the web UI. See Reboot the Hub.

Syntax
reboot

Wait approximately 15 seconds for the reboot to complete. When the reboot is complete, all the LEDs
turn on and then turn off, leaving the power LEDs on. For the AnywhereUSB 24 Plus model, one or both
of the power LEDs will be on.
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revert

revert
Purpose
Sets a particular group of a Hubs settings to its default values. Only one settings-group keyword can
be specified per revert command. That is, entering several keywords on a single command to revert
multiple settings is not allowed. A revert all command reverts all device settings but network,
security, and host key/certificate settings.

Syntax
revert [option]

Options
cloud
Reverts the Remote Manager settings to the default settings.
host
Reverts the host name set by the set host command.
network [all|globalsettings|interface=comma separated list of interface names]
Reverts these settings:
n Ethernet settings, configured by the set ethernet command.
n

Network settings, configured by the set network command.
revert network all
Reverts settings for all interfaces to default settings.
revert network globalsettings
Reverts the global network settings. See set network for details on these options.
revert network interface=[comma-separated list of interface names]
Reverts the interface-specific network settings for the specified interfaces. The
interface option can be abbreviated as if.
revert network
revert network with no options is equivalent to revert network all.

service
Reverts the service settings to the default settings.
system
Reverts the system settings to the default settings.
time
Reverts the time settings to the default settings.
usbclient
Reverts the client list to default client list.
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revert

usbgroup
Reverts to the groups to the default group list.
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set cloud

set cloud
Purpose
Enables you to enable and configure the Hub's access to Remote Manager.
Note This command performs the same functions as the options in the Remote Manager
Configuration page in the web UI.

Syntax
set cloud [options]

Options
server=[server address text]
Enter the name of your Remote Manager server.
enable=[on|off]
Enables or disables Remote Manager.
reconnect=[none|(10-3600 seconds)]
Specify the amount of time to wait after the Hub has been disconnected from Remote Manager
before the Hub should automatically try to reconnect. The time is measured in seconds.
rxkeepalive=[5-7200 seconds]
Specify the interval at which the Hub sends a keep-alive packet to Remote Manager if the Remote
Manager connection is idle. Remote Manager expects to receive either Remote Manager protocol
messages or keep-alive packets at the specified interval. The time is measured in seconds.
txkeepalive=[5-7200 seconds]
Specify the interval at which the Remote Manager-registered Hub sends a keep-alive packet to
Remote Manager if the Remote Manager connection is idle. The Hub expects to receive either Remote
Manager protocol messages or keep-alive packets at the specified interval. The time is measured in
seconds.
waitcount=[2-64]
Specify the number of consecutive keep-alives can be missed before the connection between Remote
Manager and the Hub is considered lost and subsequently closed by the Hub and Remote manager.
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set host

set host
Purpose
Configures a name for the Hub, also known as a host name, or displays the current host name for the
Hub.
Note The name can consist of the following characters: 0-9, A-Z, a-z, dash (-), or period (.). You cannot
use spaces, underscores (_), comma (,), forward slash (/), back slash (\), or ampersand (&).

Syntax
Configure a host name for the device
set host name=name

Display the current host name
set host

Options
name=name
The name for the Hub. If provided, this host name is placed in the DHCP Option 12 field when the
device is configured as a DHCP client (by set network) and requests IP configuration from a DHCP
server. This is an optional setting that is only used when DHCP is enabled.
The name can be up to 32 characters long and can contain any alphanumeric characters, and can also
include the _ (underscore) and - (hyphen) characters.

Examples
Set a host name
#> set host name=hqgateway

Remove an added host name
#> revert host

or
#> set host name=""
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set network
Purpose
Sets and displays network interface settings.

Syntax
Set network configuration options
set network [options]

Display current network configuration options
set network

Options
interface specific options
Set configuration options for network interfaces for the Digi device.
globalsettings
Global network settings include setting a gateway priority; that is, the default gateway is used to
route IP packets to an outside network, unless controlled by another route, and the device’s use of
Domain Name Server (DNS).
ip=[ipaddr]
Sets the device IP address when DHCP is off.
submask=[subnet mask]
Sets the device subnet mask address when DHCP is off.
gateway=[gateway ip address]
Sets the network gateway IP address.
The following three IP address options have a precedence. That is, if all three options are turned on,
the order of precedence is: static, dhcp, autoip.
dhcp=[on|off]
When enabled, the device attempts to use the DHCP protocol to find an IP address, gateway address,
and submask. The default is on
dns1=[primary dns server ipaddr]
The name of the primary DNS server.
dns2=[secondary dns server ipaddr]
The name of the secondary DNS server.
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set network

Examples
Manually set the device IP address
#> set network ip=10.0.0.1 gateway=255.255.255.0 submask=255.255.255.0
dhcp=off

Enable DHCP
#> set network dhcp=on
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set service
Purpose
Used to:
n Enable and disable network services.
n

Change the network port on which a given service listens.

n

Display the entire service table, or an entry in the service table.

Syntax
Enable/disable network services or change network port for service
set service [range=range]
[state={on|off}]
[ipport=network_port]

Display service table or entries in the table
set service [range=range]

Options
range=range
Used to specify the index of the network service to which the rest of the command’s options apply.
This range varies among Digi devices. Enter set service to display the index numbers for the network
services on your Digi device.
state={on|off}
Used to enable or disable a given network service.
ipport=network port
Used to change the network port on which a given network service listens.

Supported network services
The following table shows the network services controlled by the set services command and the
services provided.
The following types of network services are available:
Service

Services Provided

HTTP

Hypertext Transfer Protocol, also known as Web Server. Provides
access to web pages for configuration that are secured by
requiring a user login. A user login is required for AnywhereUSB
Plus Hubs.
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set service

Service

Services Provided

HTTPS

Hypertext Transfer Protocol over Secure Socket Layer), also
known as Secure Web Server. Provides access to web pages for
configuration that can be secured by requiring a user login, with
encryption for greater security.

SSH

Secure Shell service. Allows users secure access to log in to the
Digi device and access the command-line interface.

AnywhereUSB
MDNS

The MDNS port is not configurable.

Examples
Disable HTTP
#> set service range=4 state=off

Change the network port (ipport) of a service
#> set service range=4 ipport=500

Displaying the service table
In this example, the set service command displays the entire service table.
#> set service

Displaying an entry in the service table
In this example, the set service command displays a range of entries in the service table.
#> set service range=2-4
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set system

set system
Purpose
Configures and displays system-identifying information, such as a description of the device, its
location, and a contact person.

Syntax
Change system-identifying information
set system [description=string]
[location=string]
[contact=string]

Display system-identifying information
set system

Options
description=string
A description of this device. The maximum length is 64 characters. The default is "" (blank description
field).
location=string
The location of this device. The maximum length is 64 characters. The default is ""(blank location
field).
contact=string
The contact for this device. The maximum length is 64 characters. The default is ""(blank contact
field).

Examples
Set description, contact, and location
#> set system description="Engineering printer" location="Room 1347"
contact="John Doe at x-3749"
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set time

set time
Purpose
Sets the Coordinated Universal Time (UTC) and/or system time and date on a Digi device.
All Digi devices maintain time and date as the UNIX epoch (00:00:00, January 1, 1970) plus device uptime. On devices with no real-time clock (RTC), date and time revert to the UNIX epoch on each reboot
or power-cycle. On devices with a RTC, date and time is the UNIX epoch plus time since initial powerup.
On a Digi device with no real-time clock and no configured clock source, time and date are completely
local to the device and have limited usefulness since they are not persistent over reboots/powercycles.
On a device with a RTC and no configured clock source, time and date are also local to the device, but
they are meaningful because they are persistent.
On a device with a configured clock source, time and date received from a clock source are expected
to be UTC.

Syntax
set time [options]

Options
time=hh:mm:ss|hh:mm
The time. Hours can range from 00 to 23, minutes can range from 00 to 59, and seconds can range
from 00 to 59. If omitted, all default to 00.
date=mm.dd.yy
The date. Month can range from 01 to 12, day can range from 01 to 28, 29, 30, or 31, depending on the
month and leap year, and year can range from 00 to 36, representing the years 2000 through 2036.
timezone=string
Enter the time zone name, such as CST6CDT or Chicago.
ntp_enable=on|off
Enable or disable time server synchronization.
serverN=ntp server name
The name of the NTP server, where N is the server number.
N=server index [1-4]
Specify the number of the NTP server.

Example
Set NTP server #1 to 0.time.digi.com
#> set time server1=0.time.digi.com
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set time

Set the date and time to 2:15 PM, April 3, 2008
#> set time time=14:15 date=04.03.08
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set usbclient

set usbclient
Purpose
Add a client ID to the client list. When a computer searches for Hubs, any computer with a client ID on
the client list can connect to the Hub. You can also add client IDs in the web UI. See Manually add a
client ID.
Automatically register or reject computers that have not previously connected to the Hub. See
Automatically register unknown clients for more information.

Syntax
set usbclient [option]

Options
Use these options to add a client ID to the client list.
index=[1-24]
Specify the client index.
id=[string]
Specify the client ID for the computer.
description=[string]
Specify a descriptive name for the computer.
groups=[list]
Specify the groups this client ID can access.

Use these options to register or reject unknown clients.
autoreg=[on|off]
Determine whether unknown clients should be registered.
autoreg_groups=[list]
List the group numbers to which an unknown client is allowed access.

Examples
The client ID can access one group
set usbclient index=1 group=1

The client ID can access multiple groups
The AnywhereUSB Manager can connect to one or all of these groups at one time.
set usbclient index=3 groups=1,6-8
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set usbclient

Automatically register unknown clients
set usbclient index=3 autoreg=on
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set usbgroup

set usbgroup
Purpose
Assign a name to each group and specify the ports in each group. When a client connects to a group in
the AnywhereUSB Manager, the user has access to all of the ports in the group.
You can change the name for a group in the Group Description field. By default, a group is named
"Group" appended by a consecutive number, such as Group 1, Group 2, and so on. This name displays
in the Group Name field in the Group Status pane.
For each group, you can specify ports. Each port can only be assigned to one group. Any unassigned
ports are selected in the Unassigned row that displays beneath the list of groups.
You can also do this in the web UI. See Create groups and assign ports to the group.

Syntax
set usbgroup [option]

Options
group=[1-24] ports = [list]
Specify group number to change and a single port or a range of ports to assign to this group.
Note Ports can only be assigned to one group at a time. If a port is assigned to a new group, it is
removed from the current group.
description=[string]
Enter a name for the group. You must have double quotes around the name if the name has spaces.

Examples
Specify a group name
set usbgroup group=1 description=usergroup1
set usbgroup group=1 description="user group 1"

Assign ports to a group
Assign ports 1, 2, 3, 4, and 7 to group 1.
set usbgroup group=1 ports=1-4,7

Assign port 8 to group 3.
set usbgroup group=3 ports=8
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show

show
Purpose
Displays the current settings in a Hub.

Syntax
show [options] [options

Options
[options] [options]
Specifies which settings in the device to show, for example, show time. The following table shows the
options can be specified.
options
Lists any additional options, which depend on the settings group.
Throughout these descriptions, the following descriptions apply to the port and range
options:
port=range
Identifies a particular serial port. Optional on a single-port device.
range=range
A configuration table entry or range of entries.
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who

who
Purpose
Displays active connections to and from the Hub.

Syntax
who

Examples
Display a list of all current connections
#> who
ID Local address
-- --------------------1
10.10.12.14:18574
2
10.10.12.14:18574
3
10.10.12.14:18574
4
10.10.12.14:18574
5
10.10.12.14:22
6
10.10.12.14:60348
7
10.10.12.14:18574
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Remote address
--------------------10.10.12.19:57536
10.10.12.16:37298
10.10.12.11:50217
10.10.12.12:34844
10.10.12.16:37301
52.73.177.207:3199
10.10.12.28:37324

Service
-------------------AnywhereUSB
AnywhereUSB
AnywhereUSB
AnywhereUSB
Command line
Remote manager
AnywhereUSB
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Deployment
This process describes how to re-deploy a Hub.
Note If you want to deploy a new Hub, see Get started.
1. If you are re-deploying a Hub, remove the Hub from the network.
2. Make a connection between the Hub and each computer that should be allowed to connect to
the Hub.
a. Connect the hardware.
b. Verify initial connection.
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Security
Security-related features in AnywhereUSB® Plus include:
n Unique password for each Hub. See Change the Hub password.
n

Configurable network service port numbers.

n

Secure access and authentication to the web UI and CLI.

n

One password, one permission level.

n

Selectively enable and disable network services such as mDNS, HTTP/HTTPS, and SSH.

n

Encrypted AnywhereUSB® Plus traffic: The USB-over-IP traffic is encrypted and authenticated
by default. This cannot be disabled.

Client ID
The client ID is a unique identifier assigned to a user account the first time a user logs in to a
computer and opens the AnywhereUSB Manager. During this process, the AnywhereUSB Manager
creates a secure identity certificate that is associated with the client ID. This certificate is used to
validate your user account with the Hub.
After a user has created a client ID for their user account, the computer is able to connect to the Hubs
that recognize that client ID.

Create a client ID during initial launch of the AnywhereUSB Manager
The AnywhereUSB Manager can be initially opened by a user in one of the following ways:
n Installation: When the AnywhereUSB® Plus Hub software is installed, the Launch
AnywhereUSB Manager option is selected by default. When the installation completes, the
client ID confirmation dialog appears. The user enters a client ID, and then the AnywhereUSB
Manager is automatically opened.
Note If the user deselects the Launch AnywhereUSB Manager option, the AnywhereUSB
Manager does not automatically open after the installation process completes. In this case,
the client ID dialog does not display.
n

New user logs in: After the AnywhereUSB® Plus Hub software is installed, any user can log
into that computer and open the AnywhereUSB Manager. The first time a user opens the
AnywhereUSB Manager, the client ID dialog appears. The user must enter a client ID before
the AnywhereUSB Manager will open.
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Client ID

After the initial launch of the AnywhereUSB Manager, the next time the user logs in, the computer is
able to connect to the Hubs that recognize that client ID.

Multiple user accounts with the same client ID
In some cases, multiple computers may inadvertently use the same client ID. When this occurs and
computers with the same client ID attempt to connect with the same Hub, the first computer to
associate itself with the Hub will be able to connect to the Hub. Subsequent computers will not be
able to connect that Hub.
If you discover that multiple computers are assigned the same client ID, see AnywhereUSB Manager
client ID is not unique for help solving this issue.
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Troubleshooting
The following information provides troubleshooting steps for the most common issues. To find
information on other issues, visit our Knowledge Base at knowledge.digi.com.
AnywhereUSB Manager client ID is not unique
No remote Hubs found
Hide a group in the AnywhereUSB Manager
Invalid Hub certificate
Services turned off and locked out of the Hub
Microsoft Windows restrictions
Hubs and virtual machines
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Troubleshooting

AnywhereUSB Manager client ID is not unique

AnywhereUSB Manager client ID is not unique
When you install the AnywhereUSB Manager, you must assign a client ID to your computer, which
must be unique.
Note See Client ID for more information about how the client ID is used by your computer and the Hub
to create a connection.
In some cases, multiple computers may inadvertently be used by the same client ID. When this occurs,
and computers with the same client ID attempt to connect with the same Hub, the first computer to
associate itself with the Hub will be able to connect to the Hub. Subsequent computers will not be
able to connect to that Hub.
You can fix this issue by changing the client ID of your computer to a unique client ID. See Change the
client ID.

No remote Hubs found
When the host computer is unable to discover any AnywhereUSB® Plus devices on the network, no
Hubs are displayed in the AnywhereUSB Manager.

Firewall software blocks the port used for Hub discovery
When firewall software blocks the port used for Hub discovery, try the following:
n For firewall software, either disable it or add an exception for the port (UDP port 5353).
n

Check for a link light on the Ethernet port. If the link light is not lit, connect all of the Hubs to
switches using network cables.

n

Connect the Hub directly to the host computer.

n

Some anti-virus software might block the connection. You can either temporarily disable it or
add an exception for the AnywhereUSB Manager executable.

n

If the Hub is across a switch or router that does not forward Bonjour traffic, the
AnywhereUSB Manager will not be able to discover the Hub. In this case, add the Hub to the
known Hubs list. See Manage the list of known Hubs.

n

The firewall or router may block access to the AnywhereUSB port, which by default is TCP port
18574. If the Hub can be discovered but the connection fails (the state of the connection is
"Unable to connect"), you may need to reopen the AnywhereUSB port.

Hide a group in the AnywhereUSB Manager
Any group that has ports assigned to it displays in the AnywhereUSB Manager, even if no USB devices
are connected to a port. If you don't want groups with unused ports to display in the AnywhereUSB
Manager, you can reassign all of the ports in a group to a different group. Once the group does not
have any ports assigned to it, that group will not display.
1. Open the web UI from your selected Hub.
2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.
3. Locate the group that has the unused ports.
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Invalid Hub certificate

4. Reassign each port in the group to a different group, or to the Unassigned row.
5. When done, click Apply to save the changes.
6. Return to the AnywhereUSB Manager. The group no longer appears.

Invalid Hub certificate
In some situations, the Hub certificate may become invalid. If this occurs, you can reset your
AnywhereUSB Manager to the default configuration. Be sure to keep your client ID.

To fix an invalid certificate on a Hub:
1. Open the AnywhereUSB Manager.
2. Select File > Preferences. The Preferences dialog appears.
3. Click the Setup tab.
4. Click Restore default settings. A dialog appears.
5. Select the Keep Client ID option. This is selected by default.
6. Click OK. A "Restart required." message appears in the Preferences dialog.
7. Click Save and Quit. The AnywhereUSB Manager closes automatically. The next time you
launch the AnywhereUSB Manager, the default settings will be restored.

Services turned off and locked out of the Hub
If you use the set service CLI command to turn off services, be aware that if you turn off all of the
services and the web UI, you will be locked out of the Hub and unable to access it.
If this happens, follow the process below to reconnect to the Hub.
1. Remove the Hub from the deployed network.
2. Press the Reset button on the Hub to restore the factory defaults.
3. Connect the hardware.
4. Verify initial connection.
5. Configure the Hub settings.
6. Reconnect the Hubs to the existing AnywhereUSB Managers.
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Microsoft Windows restrictions

Microsoft Windows restrictions
Microsoft Remote Desktop
Some devices (such as a web camera), and some input devices (such as a USB keyboard or a mouse),
are blocked and may not display when Microsoft Remote Desktop is connected to a laptop or a virtual
machine.
For example, laptop A is connected to an AnywhereUSB® Plus Hub on the network, and a web camera
is connected to a port on the Hub. Laptop A is able to see the video feed from the camera.
A user on laptop B can use Microsoft Remote Desktop to gain access to laptop A. In this situation, the
video feed for both laptop A and laptop B is restricted by Windows and neither user can view the video
feed from the web camera.

Hubs and virtual machines
Hubs may not function properly when attached to a Guest OS on a virtual machine.
To resolve this issue, ensure that the extensions for the virtual machine have been installed on the
Guest OS.
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Hardware
The physical dimensions, environmental, and power requirements of the AnywhereUSB® Plus Hub can
be found in the appropriate datasheets.

Use the Reset button to restore factory defaults
Note Using the reset button is the most extreme factory reset option.
If the AnywhereUSB® Plus Hub is physically accessible, you can use the Reset button on the Hub to
restore the configuration to factory defaults. The restore process clears all current settings (including
all previously stored client IDs and certificates), deletes all Hub and AnywhereUSB Manager keys,
resets the password for the administrative user, and restores the settings to the factory defaults.
Note You can also restore the Hub to the factory default settings from the web UI and the factorydefault CLI command. The Reset button has the same action as the factory-default command.
However, if you restore the Hub to the factory defaults from the web UI, you have the option to retain
the IP address configuration option.
After you restore the factory defaults on a Hub, none of the existing AnywhereUSB Managers will be
able to connect to the Hub. When the Hub is restored, the Hub creates a new Hub certificate, which
will not be accepted by the existing AnywhereUSB Managers. To ensure that the new Hub certificate
is accepted by the existing AnywhereUSB Managers, you must re-deploy the Hub.
1. Hold down the front panel Reset button for about 10 seconds until all the USB LEDs blink twice.
2. Release the Reset button.
3. The Hub automatically reboots.
4. You must re-deploy the Hub.
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Regulatory and safety information
Safety warnings
Review the following safety warnings for AnywhereUSB® Plus Hub.
WARNING! Notice the following safety warnings:
n Risk of explosion if battery is replaced by incorrect battery type. Dispose of
used batteries according to the instructions.
n

This equipment is not suitable for use in locations where children are likely
to be present.

n

This is equipment is suitable for installation in Information Technology
Rooms in accordance with Article 645 of the National Electrical Code and
NFPA 75.

n

Use certified and rated Laser Class I Optical Transceiver product.

n

Ensure that the power cord is connected to a socket-outlet with earthing
connection.

n

Never open the equipment. For safety reasons, the equipment should be
opened only by skilled person.

WARNING! Risk of electric shock.

WARNING! Disconnect all energy sources.
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Safety warnings

AVERTISSEMENT! Notice the following safety warnings:
n Risque d'explosion si la batterie est remplacée par un type de pile incorrect.
Jeter les piles usées selon les instructions.
n

Cet équipement ne convient pas pour une utilisation dans des endroits où
des enfants sont susceptibles d'être présents.

n

Convient pour l'installation dans les salles informatiques conformément à
l'article 645 du code national de l'électricité et à la norme NFPA 75.

n

Utilisez un produit émetteur-récepteur optique laser de classe I certifié et
évalué.

n

Veillez à connecter le cordon d'alimentation à une prise de courant avec
mise à la terre.

n

Ne jamais ouvrir l'équipement. Pour des raisons de sécurité, l’équipement
ne doit être ouvert que par du personnel qualifié.

AVERTISSEMENT! Attention! Danger de choc.

AVERTISSEMENT! Déconnecter toutes les source d'énergie.
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